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COMMERCIAL WARRANTY

(STANDARD)

Motorola radio communications products are warranted 
to be free from defects in material and workmanship for a 
period of ONE (1) YEAR, [except for crystals and chan-
nel elements which are warranted for a period of ten (10) 
years] from the date of shipment. Parts, including crys-
tals and channel elements, will be replaced free of 
charge for the full warranty period but the labor to 
replace defective parts will only be provided for ONE (1) 
Year from the date of shipment. Thereafter purchaser 
must pay for the labor involved in repairing the product or 
replacing the parts at the prevailing rates together with 
any transportation charges to or from the place where 
warranty service is provided. This express warranty is 
extended by Motorola Communications and Electronics, 
Inc., 1301 E. Algonquin Road, Schaumburg, Illinois 
60196, to the original purchaser only, and only to those 
purchasing for purpose of leasing or solely for commer-
cial, industrial, or governmental use.

THIS WARRANTY IS GIVEN IN LIEU OF ALL OTHER 
WARRANTIES EXPRESS OR IMPLIED WHICH ARE 
SPECIFICALLY EXCLUDED, INCLUDING WARRAN-
TIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. IN NO EVENT SHALL 
MOTOROLA BE LIABLE FOR INCIDENTAL OR CON-
SEQUENTIAL DAMAGES TO THE FULL EXTENT 
SUCH MAY BE DISCLAIMED BY LAW.

In the event of a defect, malfunction or failure to conform 
to specifications established by seller, or if appropriate, 
to specifications accepted by Seller in writing, during the 
period shown, Motorola, at its option, will either repair or 
replace the product or refund the purchase price thereof, 
and such action on the part of Motorola shall be the full 
extent of Motorola’s liability hereunder.

This warranty is void if:

a. the product is used in other than its normal and cus-
tomary manner;
b. the product has been subject to misuse, accident 
neglect or damage;
c. unauthorized alterations or repairs have been made, 
or unapproved parts used in the equipment.

This warranty extends only to individual products, batter-
ies are excluded, but carry their own separate limited 
warranty. Because each radio system is unique, Motor-
ola disclaims liability for range, coverage, or operation of 
the system as a whole under this warranty except by a 
separate written agreement signed by an officer of 
Motorola.

Non-Motorola manufactured products are excluded from 
this warranty but subject to the warranty provided by 
their manufacturers, a copy of which will be supplied to 
you on specific written request.

In order to obtain performance of this warranty, pur-
chaser must contact its Motorola salesperson or Motor-
ola at the address first above shown, attention Quality 
Assurance Department.

This warranty applies only within the United States.

WARNING

This equipment generates, uses and can radiate radio fre-
quency energy and if  not installed and used in accor-
dance with the instruction manual, may cause interference 
to radio communication. It has been tested and found to 
comply with the limits for a Class A computing device pur-
suant to Subpart J of Part 15 of FCC Rules, which are 
designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to 
cause interference in which case the user at his own 
expense will be required to take whatever measures may 
be required to correct the interference.
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Chapter 1
Introduction

About the CSDM Lite

The CommandSTAR Lite System Database Manager (CSDM Lite) is a powerful configura-
tion and maintenance tool for a CommandSTAR Lite system. Through the use of an intui-
tive menu-driven interface, it is possible to configure a CommandSTAR Lite system to 
meet numerous requirements. The CSDM Lite allows you to:

• produce the CommandSTAR Lite system configuration file and save it to disk or 
upload it to the system

• produce diagnostic logs (or lists) of system events

• remotely access the CommandSTAR Lite system via modem

Note: For information on the Labels program to produce labels for your system, refer to 
Appendix A.

Hardware Configuration of the CSDM Lite

The CSDM Lite consists of the following components (minimum):

• Intel-based PC 486 or better

• DOS Version 5.0 (or better) or Windows 95/98

• Keyboard

• Color monitor (VGA)

• Hard Disk (100 MB)

• 16 MB RAM

• CSDM Lite software

• Printer port

• Mouse

• One COM port reserved for communications with a CommandSTAR Lite console (with 
or without modem)

Note: The CSDM Lite can run under Windows 95/98/ME (DOS Window), but is not com-
patible with Windows NT, 2000 or XP.
CommandSTAR Lite System Database Manager Manual 1-1
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Introduction
About this Manual
About this Manual

This manual explains the use of the CSDM Lite. This manual is organized as follows:

Chapter 1: Introduction - gives information about the CSDM Lite, and the CSDM Lite 
manual.

Chapter 2: Navigating - explains how to install, start, and navigate through the CSDM 
Lite.

Chapters 3 to 7 - explain the purpose and use of each of the menu items on the CSDM 
Lite menu bar.

Appendix A: The “Labels” Program - explains how to use the Labels program that 
accompanies the CSDM Lite.

Appendix B: Paging Codes - explains and shows the tables for 6 commonly used paging 
code formats.

Appendix C: Call Event Logging Printout Examples - shows typical printout examples 
for the Call Event Logging feature.

Glossary - defines specialized words, abbreviations, and acronyms.

Index - The index is found at the end of the manual.
1-2 CommandSTAR Lite System Database Manager Manual
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Chapter 2
Navigating

Installing the CSDM Lite Program

To install the CSDM Lite using diskette (DOS)

1. Place CSDM Lite Setup diskette in a floppy disk drive.

2. Change the DOS prompt to that of the drive containing the CSDM Lite Setup diskette. 
Do this by typing “a:” or “b:” at the DOS prompt.

3. Type “Setup”.

The CSDM Lite Setup screen appears.

4. Select Continue.

You are prompted to accept or change the default directory “C:\CSDMLite”.

5. Select Continue.

The installation starts.

6. When the installation is complete, select Exit.

You are returned to the DOS prompt.

To install the CSDM Lite using diskette (Windows)

1. Place CSDM Lite Setup diskette in a floppy disk drive.

2. Select the drive containing the CSDM Lite Setup diskette.

3. Click on Setup.exe to execute the setup program and follow the instructions provided.

To install the CSDM Lite using CD (Windows)

1. Place the CommandSTAR Lite Setup CD in the CD drive.

The CommandSTAR Lite Setup screen appears.

If the Setup screen does not appear: select Start>Run and type in the CD drive letter 
followed by “setup”, for example “D:\setup”.
Or, select the Browse button to locate and highlight the SETUP.EXE file on the CD, 
select Open, and then select OK to display the Setup screen.
CommandSTAR Lite System Database Manager Manual 2-1
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Navigating
Starting the CSDM Lite Program
2. Select Continue to install in the default directory “C:\CSDMLITE” or type in a new 
path before selecting Continue.

3. Select OK when Setup is complete and close the Finished - SETUP window.

Starting the CSDM Lite Program

If your PC has not been set up to start the CSDM Lite automatically, you must start it man-
ually. To start the CSDM Lite manually:

1. At the DOS prompt (in the directory where the CSDM Lite program is installed), 
type CSDMLite 

2. Press [Enter].

The basic CSDM Lite screen appears.

The CSDM Lite program can also be run as a DOS window under Microsoft Windows®. 
The working directory should be the same as the directory where the CSDM Lite program 
is installed. 

Depending on the tasks to be performed, you can run the CSDM Lite when it is:

• not connected to the system

• connected to the system

For example, if you wish to modify an existing system configuration from a disk, there is no 
need to be connected to the system. 

Figure 2-1: The Basic CSDM Lite Screen
2-2 CommandSTAR Lite System Database Manager Manual
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Login Privileges
However, if you wish to modify the current system configuration or use the diagnostics or 
upgrade menus, you will need to be connected to the system.

Connected to the System

If you start the CSDM Lite when the PC is connected to the CommandSTAR Lite system, 
the active configuration (Active config.) field shown below the menu bar in the top right 
corner of the screen, blinks and informs you that the CSDM Lite is receiving the configura-
tion from the system: 

Active config.: RECEIVING DB

This means the CSDM Lite software is receiving the SYSTEM configuration automatically. 
This procedure may take as long as 20 seconds, depending on the size of the system con-
figuration. The moment the configuration is received and loaded the message reads:

Active config.: SYSTEM.DB

Not Connected to the System

If you start the CSDM Lite when the PC is not connected to the system, the active configu-
ration (Active config.) field informs you that no configuration is being received:

Active config: NONE

Another indication that the CSDM Lite is not connected to the system, is the following 
message which indicates that the CSDM Lite-Console data link failed.

To remove this message, select OK.

Login Privileges

There are three user levels in the CSDM Lite:

• Basic

• Supervisor

• Superuser

All users have access to the basic level. Basic level users have access to the File, Diag-
nostics and Setup menus.

At the supervisor level, users have access to the File, Diagnostic, and Setup menus, and 
limited access to the Configuration menu

Figure 2-2: CSDM Lite-Console Data Link Failure
CommandSTAR Lite System Database Manager Manual 2-3
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Login Procedure
At the superuser level, users have full access to the File, Configuration, Diagnostics, 
Setup, and Upgrade menus.

Login Procedure

In order to operate the CSDM Lite at the superuser or the supervisor level, you must first 
login.

User names and passwords can be changed. All user names and passwords are case 
insensitive, can be alphanumeric, and can be up to 16 characters long. Supervisors can 
change their own passwords through the “Setup/Change Password” menu item. Through 
the “Setup/Account Management” menu item, superusers can change their own user 
names and passwords as well as the user names and passwords of supervisors.

To log into the CSDM Lite at the superuser or the supervisor level:

1. Select the “File” menu.

2. Select “Login”

The CSDM Lite Login screen appears.

3. Type your user name in the “Name” field. Press [Enter].

4. Type your password in the “Password” field. Press [Enter] twice.

Default user names and passwords are provided when you first acquire the CSDM Lite. 
These are: 

Figure 2-3: The CSDM Lite Login Screen

Level User name Password

Supervisor supervisor1 
supervisor2

supervisor1
supervisor2

Superuser superuser superuser
2-4 CommandSTAR Lite System Database Manager Manual
(6880309K01-C — July 11 2003)



Navigating
Logout/Exit Procedure
Logout/Exit Procedure

To log out and exit the CSDM Lite:

1. Select the “File” menu.

2. Select “Logout”.

You are returned to the basic CSDM Lite.

3. Select the “File” menu.

4. Select “Exit”.

Note: When you exit, the CSDM Lite can no longer record system events. (See “Diagnos-
tics/View Logs”. 

Menus

The menu bar (see Figure 2-4) is located at the top of the screen. Menus appear when 
you select items from the menu bar.

Menus are made up of menu items. When there is an arrow (a greater than sign (>)) on 
the right of the menu item, it means the menu item opens a sub-menu (see Figure 2-5).

Figure 2-4: The Menu Bar

Figure 2-5: A Typical Menu and Sub-menu
CommandSTAR Lite System Database Manager Manual 2-5
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Manual Terminology and Conventions
Manual Terminology and Conventions

In this manual, the word “you”, as in “This field allows you to ...”, refers to the CSDM Lite 
user.

The word “indicate”, as in “this field indicates”, means that the value is for display only and 
cannot be changed.

The word “system” refers to the CommandSTAR Lite system.

The word “dispatcher” refers to the operator of a CommandSTAR Lite console.

The following convention is used to indicate the path from a menu to a submenu item:

File/Report/Label

Menu Map

Figure 2-6 shows all the menus and submenus that are available to the superuser in the 
CSDM Lite.

Mouse Functions

When the mouse is active on the screen, a mouse cursor (or mouse pointer) in the shape 
of a small rectangle is visible. You can point the cursor at any field (active area) on the 
screen by moving the mouse. In this manual, when you are instructed to select a field, it 

Figure 2-6: Menu Map for the CSDM Lite
2-6 CommandSTAR Lite System Database Manager Manual
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CSDM Lite Help Screen
means place the cursor on the field and click the left mouse button. The field will become 
highlighted as you press the left mouse button. If “Field autodetect” (located through the 
Setup/Software Setup menu item) is enabled, fields will be highlighted when they are 
passed over by the cursor. 

You can also select fields by using the Tab and Enter keys on the keyboard.

CSDM Lite Help Screen

If a field is highlighted and you press F1, a help message related to the highlighted field 
appears.

Key Functionality

Escape Key [Esc]

Depending on the screen being used, the escape [Esc] key highlights the OK, SAVE, 
DONE or CANCEL buttons. If no window is opened, the escape key highlights the “File” 
menu title in the menu bar.

Insert Key [Insert]

Toggles between “insert” and “typeover” modes for edit fields.

Tab Key [Tab] 

The tab [Tab] key allows you to move from field to field from the top to the bottom of the 
screen.

Shift Plus Tab Keys [Shift+Tab] 

The combination the of shift and tab keys [Shift+Tab] allows you to move from field to field 
from the bottom to the top of the screen.

Delete Key [Delete] 

Deletes text to the right of the cursor in an edit field.

Backspace Key [Backspace] 

Deletes text to the left of the cursor in an edit field.

Enter Key [Enter] 

The enter [Enter] key allows you to:

• scroll a highlighted selection list field from one value to the next

• select a menu from the menu bar
CommandSTAR Lite System Database Manager Manual 2-7
(6880309K01-C — July 11 2003)



Navigating
Screen Saver
• select a menu item from a menu

• accept the value in an edit field and move to the next field

• toggle a check box field

F1 Key

The F1 function key activates the HELP screen.

Up/Down Arrow Keys

The up/down arrow keys move the cursor up and down within menus, selection lists, and 
scroll lists.

Left/Right Arrow Keys

The left/right arrow keys move the cursor left and right within the menus and edit fields.

Page Up/Down Keys

In a menu, the page up/page down keys move the cursor to the top or the bottom of the 
menu. In a list, these keys move the cursor to the top or the bottom of the portion of the list 
that is displayed on the screen. If the key is pressed again, the next portion of the list is 
displayed.

Home/End Keys

In a menu, the home/end keys move the cursor to the top or the bottom of the menu. In a 
list, these keys move the cursor to the top or the bottom of the list.

Screen Saver

The screen saver reduces the possibility that a screen display will burn an image into the 
face of the picture tube. The screen saver starts when the CSDM Lite position is idle for a 
predefined period of time (see the section of this manual entitled “Chapter 6/Setup 
menu”). When the screen saver is on, the message Press any key to restore the CSDM 
moves at random around the screen at 5-second intervals. 

The screen saver only affects the screen display. While the screen saver is on, the CSDM 
Lite event logging capabilities are still enabled.

Fields and Lists 

The CSDM Lite uses the following types of fields and lists (see Figure 2-7).

Edit Fields

Edit fields are used for typing alphanumeric information.
2-8 CommandSTAR Lite System Database Manager Manual
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Fields and Lists
To use an edit field:

• Click on the field with the mouse to highlight it, then start typing.

OR

• Press [Tab] or [Shift]-[Tab] to highlight the field, then start typing.

To modify information in an edit field, use the left and right arrow, backspace, delete, and 
insert keys.

To finish using an edit field, click on another field or press [Tab], [Shift]-[Tab] or [Enter].

If you type an invalid alphanumeric value into an edit field, the “OK” button is deactivated.

Check Box Fields

Check boxes toggle an item between “enabled” and “disabled”. “Enabled” is shown by a 
check mark or an X, “disabled” is shown by a small rectangle.

To use a check box field:

• Click on the field with the mouse. The field toggles between enabled and disabled.

OR

• Press [Tab] or [Shift]-[Tab] to highlight the field, then press [Enter]. The field toggles 
between enabled and disabled.

Selection List Fields

Selection list fields (see Figure 2-7) provide a list of values from which the desired value 
can be selected.

To use a selection list field using a mouse:

1. Click on the left part of the field to scroll though the values
OR
Click on the arrow at the end of the field to open and view the whole list at once.

2. Click on the desired item in the selection list.

To use a selection list field using the keyboard:

1. Press [Tab] or [Shift]-[Tab] to highlight the field.

2. Press [Enter] to display the list.

3. Use the up and down arrow keys to highlight the desired item in the selection list. Or, 
type a letter corresponding to the first letter of the desired item.

4. Press [Enter] to select the item.
CommandSTAR Lite System Database Manager Manual 2-9
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Fields and Lists
5. Press [Tab] to move to the next field.

Buttons

Buttons contain text that identifies the action that will take place if the button is selected.

Scroll Lists

Scroll lists (see Figure2-8) are lists of items from which you can make a selection.

To select an item on a scroll list using a mouse:

1. Highlight the desired item by clicking on the arrows at the top or bottom of the scroll 
bar.

2. Click on the desired item to select it.

Figure 2-7: Typical Fields in the CSDM Lite
2-10 CommandSTAR Lite System Database Manager Manual
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Fields and Lists
To select an item on a scroll list using the keyboard:

1. To highlight the desired item, use the up and down arrow keys, the Page Up/Page 
Down keys, the Home/End keys, or the first letter of the desired item.

2. Press [Enter] to select the item.

Matrices

A Matrix (see Figure 2-9) is a group of matrix elements arranged in a tabular format.

To enable or disable a feature on a matrix using a mouse:

1. Locate the desired matrix element by finding the intersection of the two items.

2. Click on the matrix element. An “X” indicates that the element is enabled. A rectangle 
indicates that the element is disabled.

To enable or disable a feature on a matrix using the keyboard:

1. Locate the desired matrix element by finding the intersection of the two items.

2. Use the up and down, and left and right arrow keys to highlight the desired matrix ele-
ment.

3. Press [Enter]. An “X” indicates that the element is enabled. A rectangle indicates that 
the element is disabled.

4. Press [Tab] or [Esc] to move to the “OK” button.

Figure 2-8: Screen with a Typical Scroll List and Buttons
CommandSTAR Lite System Database Manager Manual 2-11
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Configuration File Setup

If you do not have a configuration database file available, the menu items under the Con-
figuration menu are dimmed. To create a new configuration database file, select 
File>New as described in Chapter 3 “File Menu”, then follow the procedures below in 
sequence. For further information on configuration, refer to the chapters that follow. 
Chapter 3 also explains how to load an existing database file if setting up a new configu-
ration file is not required.

Important: The following procedures must be performed in the order in which they occur.

To add a console:

1. Select Configuration>Console>Configuration from the menu.

The Console screen appears.

2. Type in a name and select the OK button.

Note: Save your configuration file each time a change has been made (after each procedure 
in this section) using the File>Save command, as described in Chapter 3 “File Menu”.

To enable CO lines:

1. Select Configuration>Phone Line from the menu.

The Phone Line Configuration screen appears.

2. Enable (check mark) Dual CO Line Module.

Two default lines appear in the list.

3. Select OK.

Note: Save your configuration file each time a change has been made (after each procedure 
in this section) using the File>Save command, as described in Chapter 3 “File Menu”.

Figure 2-9: Typical Matrix
2-12 CommandSTAR Lite System Database Manager Manual
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To add an I/O module:

1. Select Configuration>Console>Operator Module from the menu.

The Operator Module Configuration screen appears.

2. Select the ADD button.

The Add Operator Module screen appears.

3. Select I/O Module from the drop-down list in the Type field and click OK.

4. Click OK in the Operator Module Configuration screen.

Note: Save your configuration file each time a change has been made (after each proce-
dure in this section) using the File>Save command, as described in Chapter 3 “File 
Menu”.

To add radio channels:

1. Select Configuration>Radio Channel>Configuration from the menu.

The Radio Channel Configuration screen appears with four default radio channels.

2. To add the remaining four channels, select the ADD RADIO 5 TO 8 button.

A WARNING dialog appears to confirm.

3. Click OK.

4. Select a channel and click the EDIT button.

The Edit Radio Channel screen appears.

5. If you want to change the default name, type in a new name.

6. Click the OK button in the Edit Radio Channel screen.

7. Click OK in the Radio Channel Configuration screen.

Note: Save your configuration file each time a change has been made (after each proce-
dure in this section) using the File>Save command, as described in Chapter 3 “File 
Menu”.

To setup Custom Page:

1. Select Configuration>Paging>Custom Page from the menu.

The Custom Page Configuration screen appears.

2. Select the ADD button.

The Add Custom Page screen appears.

3. Type in a numeric three-digit code to identify the page and select OK.

4. Select OK in the Custom Page Configuration screen.

Note: Save your configuration file each time a change has been made (after each proce-
dure in this section) using the File>Save command, as described in Chapter 3 “File 
Menu”.
CommandSTAR Lite System Database Manager Manual 2-13
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To setup Page Format:

1. Select Configuration>Paging>Page Format from the menu.

The Page Format Configuration screen appears.

2. Select the ADD button.

The Add Page Format screen appears.

3. Type in any alphanumeric name and click OK.

4. Click the OK button in the Page Format Configuration screen.

Note: Save your configuration file each time a change has been made (after each proce-
dure in this section) using the File>Save command, as described in Chapter 3 “File 
Menu”.

To setup External Pager:

1. Select Configuration>Paging>External Pager from the menu.

The Edit External Pager screen appears.

2. Select a radio channel from the Channel Steering field and Enabled from the Ptt 
field.

3. Click OK in the Edit External Pager screen.

Note: Save your configuration file each time a change has been made (after each proce-
dure in this section) using the File>Save command, as described in Chapter 3 “File 
Menu”.

To add Auxiliary I/O and Relays:

1. Verify address IDs are set for the I/O module (see the Installation Manual).

2. Select Configuration>Auxiliary I/O from the menu.

The Auxiliary I/O Configuration screen appears.

3. Select ADD.

The Add Auxiliary I/O screen appears.

4. Type in an I/O Name and select ADD to add the relay.

The Select Relay for Auxiliary Output screen appears.

5. Click OK in the Select Relay for Auxiliary Output screen.

6. Click OK in the Add Auxiliary I/O screen.

7. Click OK in the Auxiliary I/O Configuration screen.

Note: Save your configuration file each time a change has been made (after each proce-
dure in this section) using the File>Save command, as described in Chapter 3 “File 
Menu”.
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Chapter 3
File Menu

The File menu has the following menu items:

• Load

• Save

• Upload

• New

• Report

• Label

• Configuration

• Exit/Logout

Load

The “Load” menu item allows you to load configuration files into the CSDM Lite from disk 
or to download the configuration from the CommandSTAR Lite system to which the CSDM 
Lite is connected. 

You must first use the “Load” menu item if you wish to:

• modify a configuration file and save it to disk

• modify a configuration file and upload it to the CommandSTAR Lite system

• upload a configuration file to the CommandSTAR Lite system

In order to load configuration files from disk, the files must be in the directory containing 
the CSDM Lite program.

In order to download the system configuration, the CSDM Lite must be connected to the 
system.

To load a configuration file:

1. Select “Load” from the “File” menu.
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The “Load Configuration from Disk” screen appears.

2. Select the desired configuration file from the scroll list.

The configuration file loads and you are returned to the “File” menu.

The active configuration (Active config.) field, below the menu bar in the top right corner of 
the screen, indicates that the configuration file you selected has been loaded. If you are 
not connected to the system, many of the menu items that were deactivated are now 
active and you can proceed with modifying the configuration. 

• In the “File” menu, the “Save” and “Report” menu items become active. 

• In the Configuration menu, all the menu items become active.

• In the Diagnostic menu, the “Status” menu item becomes active if the CSDM Lite is 
connected to the system.

Button

SYSTEM

If the CSDM Lite is not connected to the CommandSTAR Lite system, the “SYSTEM” but-
ton is deactivated.

If the CSDM Lite is connected to the CommandSTAR Lite system, the “SYSTEM” button 
allows you to download the system configuration to the CSDM Lite. Although the system 
configuration is automatically downloaded at startup, the “SYSTEM” button is useful if you 
need to download the system configuration again. This necessity might arise if you have 
made changes to the originally downloaded version but wish to discard the changes and 
start again.

Figure 3-1: Load Configuration from Disk Screen
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Save

The “Save” menu item allows you to save the active configuration file to the hard disk of 
the CSDM Lite computer. You can save a configuration that was loaded into the CSDM 
Lite from disk or downloaded from the CommandSTAR Lite system connected to the 
CSDM Lite. 

To save a configuration file:

1. Select “Save” from the “File” menu.

The “Save Configuration to Disk” screen appears.

2. Select the “SAVE” button if you wish to retain the name that is currently displayed in 
the “Filename” field.

OR

Select the “Filename” field, type the desired file name, and then select the “SAVE” but-
ton. The extension “.DB” is automatically added to the 8-character filename.

OR

Select the desired configuration file from the “Existing Configurations” scroll list and 
then select the “SAVE” button.

If the configuration file exists, you will be warned that the filename exists and you will 
be asked if you want to overwrite the existing file.

The file is saved to disk.

Buttons

SAVE

Select this button to save the configuration with the name identified in the “Filename” field 
of the window. The configuration will be saved in the directory where the CSDM Lite is 
located (ex: C:\CSDMLITE).

Figure 3-2: Save Configuration to Disk Screen
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EXPORT

The “EXPORT” button displays the “Export Configuration File” screen.

The “EXPORT” button allows you to save the configuration file using a configuration ver-
sion that can be handled by older CommandSTAR Lite systems. CommandSTAR Lite ver-
sions start at version 006.

Use the scroll list to select the desired configuration version. The selected version is dis-
played below the scroll list.

If the CSDM Lite is connected to a CommandSTAR Lite system that is using an older con-
figuration version, the version number of that older configuration appears in the “Version” 
field.

If the CSDM Lite is not connected, the message “unknown (link down)” appears in the 
“Version” field.

Select “OK” to convert the file and save it to disk.

Upload

The “Upload” menu item allows you to transfer the active configuration (the configuration 
currently in the CSDM Lite) to the CommandSTAR Lite system via the CSDM Lite-Console 
data link. 

If the CSDM Lite is not connected to the CommandSTAR Lite system, the “Upload” menu 
item is deactivated.

To upload the configuration to the system:

1. Select “Upload” from the “File” menu

Figure 3-3: Export Configuration File Screen
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The “Upload Configuration to Console” screen appears.

2. Select the “UPLOAD” button.

The configuration is uploaded to the CommandSTAR Lite system.

During the upload, the message “Uploading Data” appears in the “Upload Configuration to 
Console” screen. 

When the upload is complete, the message “Upload Successful” appears in the “Upload 
Configuration to Console” screen.

New

The “New” menu item allows you to create a new configuration file. 

When you select the “New” menu item, you are prompted to confirm your selection.

If you select “OK” the current active configuration is replaced by a new active configura-
tion. 

Figure 3-4: Upload Configuration to Console Screen

Figure 3-5: “New Configuration ?” Prompt
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Report

The “Report” menu item displays a sub-menu with the following menu items:

• Label

• Configuration

Label

The “Label” menu item allows you to produce a label file to be used with the console label 
printing program that comes with the CSDM Lite program. 

Note: For information on how to install and use the Label program please see Appendix A 
of this manual.

The console label printing program allows you to print the labels that will appear on the 
CommandSTAR Lite consoles.

Before you can create a label file, you must first load or create a configuration file in which 
buttons are defined for the operator modules.

To create a label file:

1. Select “Report” from the “File” menu.

2. Select “Label” from the sub-menu.

Two files are created and saved to disk:

• The printable label file (file with extension .LB2) (which is also displayed on screen)

• The label file used by the label printing program (file with extension .LBL).

The label file appears.

Figure 3-6: A Typical Label File
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Buttons

SEARCH

The “SEARCH” button displays the “Search for Text” window. 

To search for text:

1. Type the text you wish to find into the field provided.

2. Select “OK”.

The CSDM Lite searches for and highlights the specified text.

AGAIN

The “AGAIN” button searches for and highlights the next occurrence of the specified text. 
The search is case insensitive.

Configuration

The “Configuration” menu item allows you to produce a configuration manual which pro-
vides information on the configuration and electrical interconnection of the system. The file 
generated may be printed using the DOS “Print” command.

To create a configuration manual:

1. Select “Report” from the “File” menu.

2. Select “Configuration” from the sub-menu.

Figure 3-7: Search for Text Window
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The configuration manual file for the active configuration in the CSDM Lite is created (file 
with extension .CMA), saved to disk, and displayed on screen.

Buttons

SEARCH

The “SEARCH” button displays the “Search for Text” window. 

To search for text:

1. Type the text you wish to find into the field provided.

2. Select “OK”.

The CSDM Lite searches for and highlights the specified text.

AGAIN

The “AGAIN” button searches for and highlights the next occurrence of the specified text. 
The search is case insensitive.

Figure 3-8: The Configuration Manual File

Figure 3-9: Search for Text Window
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Exit/Logout

The “Logout” menu item allows you to leave the superuser level and return to the Basic 
CSDM Lite.

The “Exit” menu item, which appears after you logout, allows you to exit the CSDM Lite 
program.

When you log out, the CSDM Lite still collects diagnostic information.

When you exit from the CSDM Lite, the CSDM Lite can no longer collect diagnostic infor-
mation.

To log out and exit the CSDM Lite:

1. Select the “File” menu.

2. Select “Logout”.

You are returned to the basic CSDM Lite.

3. Select the “File” menu.

4. Select “Exit”.
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Chapter 4
Configuration Menu

The items on the Configuration menu become available after a configuration file has been 
loaded into the CSDM Lite. For information on how to load a Configuration file please refer 
to the section of this manual covering the “File/Load” menu item in Chapter 3. 

After modifying the configuration file, use the “File/Save” menu item to save your changes. 

For CommandSTAR Lite to make use of the changes you have made, upload the configu-
ration file to the system by using the “File/Upload” menu item.

The Configuration menu has the following menu items:

• General • Phone Line

• Console • Paging

• Configuration • Custom Page

• Operator Module • Page Format

• Console Layout • External Pager

• Control Assignment • Manual Page

• Password Configuration • Speed Page

• Radio Channel • Paging Aliases

• Configuration • Load/Save Paging Aliases

• Assignment • Auxiliary I/O

• Cross-Muting

• Tone Signaling

• DC Signaling

• Caller ID List
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General

The “General” menu item displays the “General Configuration” screen.

Fields

Cross-Mute attenuation level - radio channel

If two radio channels interfere with one another, the audio from the keyed channel can 
crossover onto the interfering channel and be heard on the transmitting console’s speaker. 
The audio from the speaker can be picked up by the transmitting microphone and cause 
feedback.

The cross-mute feature lets you mute the audio of the interfering channel so it will not be 
heard on the speaker when the other channel is keyed.

The cross-mute feature can be set to one of two levels. The level you choose is system 
wide, that is, it is applied to all the cross-muted channels in the system. The levels are:

• Audible - lowers audio by 24 dB

• Muted - totally muted

To set the radio channel cross-mute feature, select “Radio Channel” in the “Configuration” 
menu and then select “Cross-Muting”.

Voice annotation - alert 1, 2, 3

The voice annotation - alert 1, 2, and 3 fields allow you to specify the length of time that a 
channel will be keyed for voice transmission after alert tones 1, 2, or 3 have been transmit-
ted.

Figure 4-1: General Configuration Screen
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The duration for voice annotation after an alert tone can range from 0 to 60 seconds.

The alert tone feature provides a means of transmitting a special alert tone over the 
selected radio channel(s). Alert tones assigned to operator module buttons and are acti-
vated when the buttons are pressed. Three types of alert tones are available:

• Alert 1 - provides a continuous 1 kHz tone.

• Alert 2 - provides two tones, 800 Hz and 1.5 kHz alternating at 2 Hz.

• Alert 3 - provides a 1.5khz tone alternating with silence at 2 Hz.

Clock - source

Although you can set the system time from the CSDM Lite or from the console, a clock 
source is needed to synchronize the time in each of these system entities. The “clock - 
source” field allows you to set which entity, will be the clock source for the system.

The choices are:

• CSDM (use computer system clock)

• Master - the console (use time entered on CommandSTAR Lite keypad, test #73).

• External - a device capable of receiving time information from an external source is 
linked to a console, for example, NETCLOCK. 

Note: In order for this feature to work, the console’s keypad test #73 must be set to 
“Clock”. Also, the NETCLOCK needs to be configured with the following parameters:

• 9,600 baud rate

• 1 stop bit

• 8 data bits

• no parity

Clock - type

The “Clock - type” field identifies the type of device supported by CommandSTAR Lite for 
the external clock source. The device currently supported is the Netclock2 format 1. This 
device receives time information from radio station WWVB in the United States.

Clock - host

The “Clock - host” field allows you to specify which console is linked to the external clock 
source device. For CSDM Lite, the only option is Console1.

Clock - port

The “Clock - port” field allows you to specify which port is being used to link to the external 
clock source device. For CSDM Lite, the only option is COM1.

Paging package

A number of paging formats are available with the CSDM Lite. 

The “Paging package” field allows you to choose between two paging packages, Basic 
and Extended. 
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The Basic paging package supports the following paging formats:

• Motorola 1+1

• Motorola 2+2

• GE type 99

• DTMF

• STAT-ALERT

The Extended paging package supports the following paging formats:

• All the paging formats in the Basic package

• Motorola 5 tone

• Motorola 6 tone

• Nec 5 tone

• Nec 6 tone

• Reach

• Rotary Pulse 

The Extended paging package also supports the custom paging feature.

Full duplex patch

A patch allows radio operators on separate channels to talk to one another.

The Full duplex patch feature allows the dispatcher to create a patch in which the partici-
pants can transmit and receive audio simultaneously. This is in contrast to a half duplex 
patch in which audio can only be transmitted by one participant at a time, and received by 
those who are not transmitting.

The “Full duplex patch” field allows you to enable or disable the Full duplex patch feature. 

If the field is set to enabled (checked), full duplex communication is allowed on patches. 

Note: Even if the “Full duplex patch” field is enabled, if one radio in a patch does not allow 
full duplex communication, the whole patch will be half duplex.

If the field is set to disabled (rectangle), the full duplex communication is not allowed on 
patches.

Unselect callers ID

The “Unselect callers ID” field allows you to enable or disable the Unselect callers ID fea-
ture. 

If a caller with an ID keys a channel, the ID appears on the CCM for that channel. 

If the field is set to enabled (checked), the callers ID appears on CCMs of selected and 
unselected channels.

If the field is set to disabled (rectangle), the caller’s ID appears on CCMs of selected chan-
nels.
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Caller ID min. time disp. 

The “Caller ID min. time disp.” field allows you to specify the amount of time a caller’s ID 
will remain displayed on a console CCM after the channel PTT has been released. The 
duration can be in the range of 0 to 60 seconds.

Phone hangover delay

The “Phone hangover delay” field allows you to specify the amount of time a channel will 
remain keyed in after speech stops on a patched phone line. The duration can be in the 
range of 0 to 30000 ms.

Console

The “Console” menu item displays a sub-menu with the following menu items:

• Configuration

• Operator Module

• Console Layout

• Control Assignment

• Password Configuration

Configuration

The “Configuration” menu item displays the “Console” menu.

Fields

Name

The “Name” field allows you to change the name of the console. The field cannot be left 
blank, nor can a name be duplicated.

Figure 4-2: Console Menu
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All mute time-out delay

The All Mute feature allows a dispatcher to mute all the channels on the unselect speaker 
by pressing the All Mute button on the ACM. All Mute has a predetermined duration or 
“time-out delay” after which the muting stops and the unselect audio is restored to its pre-
vious volume. If the All Mute button is pressed while the unselect audio is muted, the mut-
ing stops and the unselect audio is restored to its previous volume.

The “All mute time-out delay” field allows you to set the duration of the all mute for the con-
sole being configured. The duration can be in the range of 0 to 120 seconds. 0 represents 
an infinite duration.

All mute level

The All Mute feature allows a dispatcher to mute all the channels on the unselect speaker 
by pressing the All Mute button on the ACM. 

The “All mute level” field allows you to set the muting level of the All Mute feature. The lev-
els are:

• Audible - lowers audio by 24 dB

• Muted - totally muted 

Date and time setup

The date and time that is displayed on the CSDM Lite and on each console in the system 
can be set from the CSDM Lite or from any console if the feature is enabled on the con-
sole.

The “Date and Time setup” field allows you to control whether or not the date and time can 
be set from the console. 

If the field is set to enabled (checked), date and time can be set from the console.

If the field is set to disabled (rectangle), date and time cannot be set from the console.

Switch radio to speaker

The Switch radio to speaker feature allows you to control whether or not the audio from 
radio and telephone will switch from the headset to the speaker when call director audio is 
received. 

The “Switch radio to speaker” field allows you to enable or disable the Switch radio to 
speaker feature for the console being configured.

If the field is set to enabled (checked), the feature is allowed at the console. That is, the 
audio from radio and telephone will switch from the headset to the speaker when call 
director audio is received.

If the field is set to disabled (rectangle), the feature is not allowed at the console. That is, 
the audio from radio and telephone will remain in the headset when call director audio is 
received.

Console chime ID

Console chime is a tone or tone combination that is heard at a console when the console 
receives an intercom or telephone call. CommandSTAR Lite provides 6 different chimes. 
Each chime has its own ID number. 
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The “Console Chime” field allows you to select the chime for the console being configured. 
The choices are 0 to 5.

CO line audio level

The “CO line audio level” field allows you to set the receive gain for the console’s tele-
phone calls.

Valid CO line audio levels are between -21dB and +12dB.

Patched call dir. level

The “Patched call dir. level” field allows you to set the receive gain for the console’s call 
director calls when patched.

Valid Patched call dir. audio levels are between -21dB and +12dB.

Console auto login

The “Console auto login” field allows you to enable or disable auto login at the console.

STAT-ALERT PTT ID

The “STAT-ALERT PTT ID” field allows you to specify the ID number that will be sent when 
the console keys a channel.

For STAT-ALERT, values can range from 0001 to DEEE.

DTMF decode ID

The “DTMF decode ID” field allows you to specify the DTMF ID number of your console 
that must be received for audio to go through on the channel. Values can range from 
00000000 to 99999999.

Call director type

The basic Call Director is a telephone set that is linked to the console so that telephone 
callers can be heard and spoken to through the console’s headset.

The “Call director type” field allows you specify the type of call director for the console. 
Choices are:

• None - no call director

• Basic call director

• Enhanced - the basic call director plus the ability to include calls from the call director 
in a patch

Call director interface

The “Call director interface” field allows you to specify the type of Call Director interface for 
the console. Choices are:

• 600 Ohms

• Carbon
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Console type

The “Console type” field allows you to specify the type of console. Choices are:

• PC Console (not applicable)

• Lite Push Button

Operator Module

The “Operator Module” menu item allows you to add operator modules to consoles. You 
can add: 

• Auxiliary Control Modules (ACMs) - each ACM has 16 buttons that can be used to 
access CommandSTAR Lite features.

• three types of Channel Control Module (CCM) - CCMs allow you to control radio chan-
nels.

• Dual with display (Dual DCCM) - allows a dispatcher to control two radio chan-
nels. This module has a programmable display for each channel.

• Dual without display (Dual CCM) - allows a dispatcher to control two radio chan-
nels. As the name suggests, this module does not have a programmable display.

• Single with display (Single DCCM) - allows a dispatcher to control one radio chan-
nel. This module has one programmable display for the channel.

• Input/Output module - has 6 form C relays and 12 opto-couplers that can be used for 
any non-specific input/output function.

(See the “Control Assignment” section of this manual for information on button features.)

The “Operator Module” menu item displays the “Operator Module Configuration” screen.

The “Operator Module Configuration” screen lists the operator modules that are present 
on a console.

When you select an operator module, the “DELETE” and “VIEW” buttons become active. 

Figure 4-3: Operator Module Configuration Screen
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For the CSDM Lite, the total number of operator modules is 8. There is always one keypad 
and a maximum of 6 ACMs. The maximum number of CCMs and/or DCCMs is 4. The 
maximum number of Single DCCMs is 6.

Buttons

ADD

The “ADD” button on the “Operator Module Configuration” screen allows you to add an 
operator module to the console.

The “Add Operator Module” screen appears.

The “Add Operator Module” screen has the following fields:

Type - The “Type” field allows you to select the desired operator module. Choices are:

• Auxiliary Control Modules (ACMs)

• Dual Display Channel Control Module (Dual DCCM)

• Dual Channel Control Module without display (Dual CCM)

• Single Display Channel Control Module (Single DCCM)

• Input/Output module (I/O Box Module)

ID - The “ID” field allows you to specify a unique identification number for the selected 
operator module. 

• ACM IDs range from 00H to 05H.

• Dual CCM IDs range from 10H to 13H.

• Input/Output module IDs range from 30H to 3FH.

DELETE

The “DELETE” button on the “Operator Module Configuration” screen allows you to delete 
the selected operator module from the console.

VIEW

The “VIEW” button on the “Operator Module Configuration” screen shows the buttons that 
have been assigned to the selected operator module.

Figure 4-4: Add Operator Module Screen
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ACM

When you select the “VIEW” button for an ACM, the “View Console” scroll list for the ACM 
module appears.

The “View Console” scroll list for the ACM has the following columns:

Button - identifies the button feature

Address - identifies the button address, that is, the position of the button on the operator 
module. The button address for an ACM can range from 1 to 16 as shown below.

Figure 4-5: View Console Scroll List

Figure 4-6: ACM Button Addresses
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CCM

When you select the “VIEW” button for a CCM (Dual CCM, Dual DCCM, Single DCCM), 
the “View Console” scroll list for the CCM module appears.

The “View Console” scroll list for the CCM has the following columns:

Type - identifies the type of CCM

Regroup - identifies the regroup buttons that affect the channel assignments for this CCM

Reference - identifies the channels assigned to this CCM

I/O module

When you select the “VIEW” button for an I/O module, the “View Console” scroll list for the 
I/O module appears.

The “View Console” scroll list for the I/O module has the following columns:

Type - identifies the type of port (input or output)

Port - identifies the port number

Figure 4-7: View Console Scroll List for CCM

Figure 4-8: View Console Scroll List for I/O
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Form C - identifies whether or not the port supports a form “C” relay

Usage - identifies the use of the port

Console Layout

The “Console Layout” menu item allows you to assign operator modules to specific posi-
tions on consoles. 

This is required to correctly print out the configuration manual.

The “Console Layout” menu item displays the “Operator Module Layout” screen.

Buttons

New Layout

The “NEW LAYOUT” button clears the operator module assignments from the layout and 
replaces them with the word “BLANK”.

Figure 4-9: Operator Module Layout Screen
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Labeled Rectangles

The labeled rectangles on the “Operator Module Layout” screen represent the positions on 
the console where operator modules can be located. When you select a rectangle, the 
“Operator Module Selection” screen appears.

Use the “Operator Module Selection” screen to assign an operator module to the selected 
position on the console.

Control Assignment

The “Control Assignment” menu item allows you to assign button features to specific oper-
ator modules (ACMs and CCMs) on specific consoles. For DRCMs, the buttons are pre-
defined and specific to the radio. 

The “Control Assignment” menu item displays the “Console Control Definition” screen.

Figure 4-10: Operator Module Selection Screen

Figure 4-11: Console Control Definition Screen
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The large black rectangles on the screen represent operator module buttons, the small 
black rectangles represent LEDs and have no function on the screen.

Field

Current

Several “Control Definition” screens are available for display depending on the types of 
operator modules being used on the console. The “Current” selection list field at the bot-
tom of the screen lists the operator modules that have been assigned to the console. 
When you select the “Current” selection list field the selected operator module appears on 
the screen.

Use the [Page Up] and [Page Down] keys to display the operator modules.

Buttons

VALIDATE

If the call director feature is enabled for the console, the “VALIDATE” button on the “Con-
trol Definition” screen informs you whether or not a Call Director button has been 
assigned. This button is not available for DRCMs.

DELETE ALL

The “DELETE ALL” button on the “Control Definition” screen allows you to delete all the 
button assignments for the currently displayed screen. This button is not available for 
DRCMs.

To assign (or add) a feature to a button: 

1. Select the “Current” selection list field at the bottom of the “Control Definition” screen.

A selection list of all the available operator modules appears.

2. Select the desired operator module. 

3. Select, from the “Control Definition” screen, the button to be assigned a feature. 

Note: DRCM buttons are pre-defined and cannot be assigned features.

Figure 4-12: Available Operator Modules Selection List
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The “Feature Selection” scroll list appears.

4. Make sure that the “Mode” field is set to “ADD”, then select the feature you wish to 
assign to the selected button. 

The selected feature is assigned to the selected button.

Some button features can only be added once and after they are added they are removed 
from the selection list.

A special case of button assignment occurs when a dual button feature is involved (see 
Dual Button Features below). 

Note: The “None” feature removes a feature from a button.

5. Repeat as desired and select “OK” when you are finished.

To move a feature from one button to another: 

1. Select the “Current” selection list field at the bottom of the “Control Definition” screen.

Figure 4-13: Feature Selection Scroll List
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A selection list of all the available operator modules appears.

2. Select the desired operator module. 

3. Select the button you want to change from the “Control Definition” screen. 

The “Feature Selection” scroll list appears.

4. Make sure that the “Mode” field is set to “MOVE”, then select the feature you wish to 
assign to the selected button.

The selected feature is reassigned to the selected button. (The features are swapped 
between buttons.)

When the mode is set to “MOVE”, the selection list only contains the button features that 
are currently assigned to the console.

A special case of button reassignment occurs when dual button features are involved (see 
Dual Button Features below).

Figure 4-14: Available Operator Modules Selection List

Figure 4-15: Feature Selection Scroll List
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5. Repeat as desired and select “OK” when you are finished.

Dual Button Features

A dual button feature is a feature that needs two buttons to operate. The two buttons are 
always placed one after the other. When one of the buttons is selected on the “Control 
Definition” screen, it is indicated with a surrounding box and the other is indicated by side 
bars.

When a dual button feature is reassigned, both buttons are reassigned. 

The following features are always assigned to two buttons:

• Multiselect with memory (MSel Mem)
and
All points bulletin (APB)

• Patch with memory (PatchMem)
and
Patch transmit (Patch TX)

• Receive 
and
Mute

• Call director patch (CDir Pat)
and
Call director transmit (CDir TX)

Figure 4-16: Control Definition Screen Dual Button Selected
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Feature Descriptions for ACMs

Alarm 

The Alarm button allows a dispatcher to deactivate an I/O alarm that is sounding at the 
console. To make this button available in the “Feature Selection” scroll list you must:

1. add an auxiliary I/O using “Configuration/Miscellaneous/Auxiliary I/O”. The “Type” field 
in the “Edit Auxiliary I/O” screen must be set to C, D, E, F, G, or H. 

2. add an alarm to the I/O using the “Alarm” field in the “Edit Auxiliary I/O” screen.

Alert 1, 2, and 3

The alert tone feature provides a means of transmitting a special alert tone over the 
selected radio channels. Alert tones assigned to operator module buttons are activated 
when the buttons are pressed. Three types of alert tones are available:

• Alert 1 - provides a continuous 1 kHz tone.

• Alert 2 - provides two tones, 800 Hz and 1.5 kHz alternating at 2 Hz.

• Alert 3 - provides a 1.5khz tone alternating with silence at 2 Hz.

Alias Page

The Alias page feature transmits one preprogrammed page code automatically. No digit 
entry is required. The dispatcher only needs to scroll through a list of entries.

All Mute

The All Mute feature allows a dispatcher to mute all the channels on the unselect speaker 
by pressing the All Mute button on the ACM. All Mute has a predetermined duration or 
“time-out delay” after which the muting stops and the unselect audio is restored to its pre-
vious volume. If the All Mute button is pressed while the unselect audio is muted, the mut-
ing stops and the unselect audio is restored to its previous volume. 

The All mute level and the All mute time-out delay are set from “Configuration/Console/
Configuration” in the CSDM Lite. 

APB (All Points Bulletin) 

The APB feature allows a dispatcher to transmit an all points bulletin. The APB button 
which is always associated with the MSel Mem button allows a dispatcher to transmit 
immediately over the stored set of channels regardless of the current selection.

Intercom 

The intercom feature allows a dispatcher to talk directly to a person at a base station or 
parallel unit. The console user selects a radio channel associated with the desired base 
station or parallel unit, then presses and holds the Intercom button and talks into the 
microphone. The person at the base station or parallel unit responds by speaking into the 
base station or parallel unit microphone.

Digital Takeover

The Digital Takeover feature allows a supervisor to take over the channel to communicate 
with the radio by blocking all other consoles. Digital Takeover is activated when the super-
visor selects a digital radio channel and then presses the DigTakOv button. To deactivate 
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Digital Takeover and allow the other consoles to communicate with the radio, the
DigTakOv button is pressed again.

CDir TX (Call Director Transmit) 

The Call Director TX button allows a dispatcher to place a call through a call director inter-
face. A call director interface connects the headset or the microphone and select speaker 
of the console to a telephone that is separate from the console. 

To make this button available in the “Feature Selection” scroll list you must set the call-
director type to Basic or Enhanced using “Configuration/Console/Configuration”. 

“Basic” allows you to transmit. 

“Enhanced” allows you to transmit and create a patch. 

CDir Pat (Call Director Patch) 

The Call Director button allows a dispatcher to patch a call director call. A call director call 
is one that is made through call director interface. A call director interface connects the 
headset or the microphone and select speaker of the console to a telephone that is sepa-
rate from the console. 

To make this button available in the “Feature Selection” scroll list you must set the call-
director type to Enhanced using “Configuration/Console/Configuration”. “Enhanced” 
allows you to transmit and create a patch.

Clear

The Clear button is used to correct, remove, or erase an entry, a function, a display, or 
memory.

Line (Line 1, Line 2) 

The Line 1 or Line 2 button gives a dispatcher direct access to a phone line.

• To access a phone line, the dispatcher presses the button for the phone line and then 
dials the phone number. 

The buttons and assignments are set from “Configuration/Phone Line” in the CSDM Lite. 

For this feature to work, the CO Line must be enabled in the Phone Line menu.

EmerAlrm (Emergency Alarm) 

The Emergency Alarm button allows the dispatcher to stop an emergency alarm sounding 
at that console. As a result of pressing the button, the current emergency alarm will not be 
heard at the console, but, the emergency alarm will be heard at all other consoles with the 
channel assigned.

EmerClr (Emergency Clear) 

The Emergency Clear button allows the dispatcher to cancel the current emergency 
alarm. 

Enter RAC (Repeater Access Code) 

The Enter RAC button allows the dispatcher to change the repeater access code. 
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Flash

The Flash button allows a dispatcher to send a hook flash signal over a phone line.

Frequency

The Frequency button allows the dispatcher to specify the frequency on which to transmit 
and receive on the selected radio channel.

Hold

The Hold button allows a dispatcher to put a telephone call on hold.

I/O (Input/Output) 

The I/O button allows a dispatcher to control an Auxiliary I/O.

Man Page (Manual Page) 

The Manual Page feature allows a dispatcher to send a page by pressing the Man Page 
button and then typing the paging code. To use this feature you must:

1. Add a Man Page button.

2. Add a paging format using “Configuration/Paging/Page Format”.

3. Assign the format to the button using “Configuration/Paging/Manual Page”.

Monitor

The Monitor feature allows a dispatcher to check if anyone is using the selected channel 
before keying it. This is useful when the channel is using PL tones. PL tones prevent spe-
cific groups from receiving on the channel, yet allow those groups to transmit. Hence the 
potential exists for conflicting transmissions. If members of an excluded group wish to use 
the channel, before they transmit they can monitor the channel and find out if it is being 
used.

MSel Mem (Multi-Select with Memory) 

The Multi-Select with memory feature allows a dispatcher to select more than one channel 
at a time and stores the selected channels in memory. The APB button which is always 
associated with the MSel Mem button allows a dispatcher to transmit immediately over the 
stored set of channels regardless of the current selection.

Mult-Sel (Multi-Select) 

The Multi-Select feature allows a dispatcher to select more than one channel at a time 
(also known as simul-select).

None

“None” has no application as an operator module feature. It allows you to remove a button 
feature from a button.

Page TX (Page Transmit) 

The Page TX button allows a dispatcher to transmit a page.
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Patch

The Patch button allows the dispatcher to create a patch.

Patch TX

The Patch TX button allows the dispatcher to transmit a patch.

Patch Mem (Patch with Memory) 

The Patch Mem button allows a dispatcher to store patch settings in memory so that it can 
be recreated easily. 

PhonAsst (Phone Assist) 

The Phone Assist button allows a dispatcher to force phone line audio onto the radio dur-
ing a call director patch. 

Phone TX (Phone Transmit) 

When dispatchers have intercom or telephone conversations the audio is routed through 
the headset or, in the absence of a headset, through the console microphone and select 
speaker. When the audio is routed through the microphone and select speaker, feedback 
can occur. 

To avoid feedback telephone conversations are half-duplex:

• The dispatcher presses the Phone TX button to enable the microphone and mute 
audio from the select speaker.

• The dispatcher releases the Phone TX button to disable the microphone and unmute 
audio from the select speaker.

Queue

The Queue feature gives a dispatcher a list of the last 15 messages that were received 
over a channel.

Rad Asst (Radio Assist)

The Radio Assist button allows a dispatcher to force radio audio onto the radio during a 
call director patch.

Receive

The Receive feature adds a Receive button and an associated Mute button to an ACM. 
These buttons allow a dispatcher to select and mute a channel using an ACM. A channel 
can be assigned to the receive button using “Configuration/Radio Channel/Assignment”.

Release

The Release button allows a dispatcher to release a telephone call.

Ring Dis (Ring Disable) 

The Ring Disable button allows a dispatcher to stop the console from ringing when a tele-
phone call comes in.
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Safety

The Safety button prevents a dispatcher from pressing an I/O button at the wrong time. 
The dispatcher must press the Safety button first.

Speed Pg

The Speed Page feature allows a dispatcher to transmit one of several pre-programmed 
page codes automatically. No digit entry is required from the keypad. The code can be 
assigned to the button using “Configuration/Paging/Speed Page”.

Feature Descriptions for CCMs

Aux1 I/O and Aux2 I/O (Auxiliary I/O 1 and 2) 

The Aux I/O buttons 1 and 2 can be used for any non-specific output relay function. 

F1/2 Aux (Frequency 1, Frequency 2, Auxiliary) 

The F1/2 Aux button controls the auxiliary 1 output relay plus controls frequency 1 and 2. 
When the button is pressed, the relay is activated and frequency 2 becomes the transmit 
and receive frequency. When the button is pressed again, the relay is deactivated and fre-
quency 1 becomes the transmit and receive frequency.

F1/2 Cpl (Frequency 1, Frequency 2, Coupled) 

The F1/2 Cpl button controls frequencies 1 and 2. When the button is pressed, frequency 
1 becomes the transmit and receive frequency. When the button is pressed again, fre-
quency 2 becomes the transmit and receive frequency.

F3/4 Cpl (Frequency 3, Frequency 4, Coupled) 

The F3/4 Cpl button controls frequencies 3 and 4. When the button is pressed, frequency 
3 becomes the transmit and receive frequency. When the button is pressed again, fre-
quency 4 becomes the transmit and receive frequency.

F5/6 Cpl (Frequency 5, Frequency 6, Coupled) 

The F5/6 Cpl button controls frequencies 5 and 6. When the button is pressed, frequency 
5 becomes the transmit and receive frequency. When the button is pressed again, fre-
quency 6 becomes the transmit and receive frequency. 

F1/2 Shr (Share Frequency 1 and 2) 

The F1/2 Shr button controls frequencies 1 and 2 in the following way:

• The channel is not selected

• When the F1/2 Shr button is pressed, frequency 1 becomes the receive fre-
quency.

• When the F1/2 Shr button is pressed again, frequency 2 becomes the receive fre-
quency

• The channel is selected

• When the F1/2 Shr button is pressed, frequency 1 becomes the transmit fre-
quency.
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• When the F1/2 Shr button is pressed again, frequency 2 becomes the transmit 
frequency.

F3/4 Shr (Share Frequency 3 and 4) 

The F3/4 Shr button controls frequencies 3 and 4 in the following way:

• The channel is not selected

• When the F3/4 Shr button is pressed, frequency 3 becomes the receive fre-
quency.

• When the F3/4 Shr button is pressed again, frequency 4 becomes the receive fre-
quency

• The channel is selected

• When the F3/4 Shr button is pressed, frequency 3 becomes the transmit fre-
quency.

• When the F3/4 Shr button is pressed again, frequency 4 becomes the transmit 
frequency.

F5/6 Shr (Share Frequency 5 and 6) 

The F5/6 Shr button controls frequencies 5 and 6 in the following way:

• The channel is not selected

• When the F5/6 Shr button is pressed, frequency 5 becomes the receive fre-
quency.

• When the F5/6 Shr button is pressed again, frequency 6 becomes the receive fre-
quency

• The channel is selected

• When the F5/6 Shr button is pressed, frequency 5 becomes the transmit fre-
quency.

• When the F5/6 Shr button is pressed again, frequency 6 becomes the transmit 
frequency.

None

“None” has no application as an operator module feature. It allows you to remove a button 
feature from a button.

PL A/B (Private Line A and B) 

The PL A/B button allows a dispatcher to select private line A or B.

PL C/D (Private Line C and D) 

The PL C/D button allows a dispatcher to select private line C or D.

PL E/F (Private Line E and F) 

The PL E/F button allows a dispatcher to select private line E or F.
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Repeat

The Repeat button allows a dispatcher to enable or disable the repeater function for the 
channel.

RX F1/F2 (Receive Frequency 1, Receive Frequency 2) 

The RX F1/F2 button controls frequencies 1 and 2 in the following way:

• When the RX F1/F2 button is pressed, frequency 1 becomes the receive frequency.

• When the RX F1/F2 button is pressed again, frequency 2 becomes the receive fre-
quency.

RX F3/F4 (Receive Frequency 3, Receive Frequency 4) 

The RX F3/F4 button controls frequencies 3 and 4 in the following way:

• When the RX F3/F4 button is pressed, frequency 3 becomes the receive frequency.

• When the RX F3/F4 button is pressed again, frequency 4 becomes the receive fre-
quency.

RX F5/F6 (Receive Frequency 5, Receive Frequency 6) 

The RX F5/F6 button controls frequencies 5 and 6 in the following way:

• When the RX F5/F6 button is pressed, frequency 5 becomes the receive frequency.

• When the RX F5/F6 button is pressed again, frequency 6 becomes the receive fre-
quency.

Secure

The Secure button allows a dispatcher to encrypt a channel.

Station

The Station button allows a dispatcher to switch between the main and standby base sta-
tions.

Takeover

The Takeover button allows a dispatcher to disable a Parallel unit.

TX F1/F2 (Transmit Frequency 1, Transmit Frequency 2) 

The TX F1/F2 button controls frequencies 1 and 2 in the following way:

• When the TX F1/F2 button is pressed, frequency 1 becomes the transmit frequency.

• When the TX F1/F2 button is pressed again, frequency 2 becomes the transmit fre-
quency.

TX F3/F4 (Transmit Frequency 3, Transmit Frequency 4) 

The TX F3/F4 button controls frequencies 3 and 4 in the following way:

• When the TX F3/F4 button is pressed, frequency 3 becomes the transmit frequency.
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• When the TX F3/F4 button is pressed again, frequency 4 becomes the transmit fre-
quency.

TX F5/F6 (Transmit Frequency 5, Transmit Frequency 6) 

The TX F5/F6 button controls frequencies 5 and 6 in the following way:

• When the TX F5/F6 button is pressed, frequency 5 becomes the transmit frequency.

• When the TX F5/F6 button is pressed again, frequency 6 becomes the transmit fre-
quency.

WldCard 1 and 2 (Wildcard 1 and 2) 

The WldCard button sends tones used to operate miscellaneous devices. A wildcard has 
two frequencies. The first frequency, used to turn the device on, is sent when the wildcard 
button is pressed. The second frequency, used to turn the device off, is sent when the 
wildcard button is pressed again.

DRCM “Control Definition” Screen

When a DRCM is selected from the “Current” field of the “Control Definition” screen, pre-
defined buttons specific to the radio and a box indicating radio number and type appear.

The buttons cannot be changed or assigned features. Labels on the DRCM need to made 
manually. For further information on the buttons, refer to the CommandSTAR Lite Installa-
tion and Troubleshooting Manual.

Figure 4-17: DRCM “Control Definition” Screen
CommandSTAR Lite System Database Manager Manual 4-25
(6880309K01-C — July 11 2003)



Configuration Menu
Console
Password Configuration

The “Password Configuration” menu item displays the “Password Configuration” screen 
and is available when the “Console type” field of the “Console” screen is set to “PC Con-
sole”.

The “Password Configuration” menu item lists the passwords and their corresponding 
level of access for the console.

When you select a password from the list, the “DELETE” and “EDIT” buttons become 
active.

Buttons

ADD

The “ADD” button on the “Password Configuration” screen allows you to add a password 
with an assigned level of access.

The “Add Password” screen appears.

The “Add Password” screen has the following fields:

Password - The “Password” field allows you to assign a password.

Level - The “Level” field allows you to specify the level of access for the assigned pass-
word. Choices are:

• Operator (provides basic access)

Figure 4-18: Password Configuration Screen

Figure 4-19: Add Password Screen
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• Supervisor (provides access to supervisory features of the console)

DELETE

The “DELETE” button on the “Password Configuration” screen allows you to delete a 
password and its level of access from the “Password Configuration” screen.

EDIT

The “EDIT” button on the “Password Configuration” screen allows you to change the 
assigned password or the level of access.

The “Edit Password” screen appears.

Figure 4-20: Edit Password Screen
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Radio Channel

The “Radio Channel” menu item displays a sub-menu with the following menu items:

• Configuration

• Assignment

• Cross-Muting

• Tone Signaling

• DC Signaling

• Caller ID list

Configuration

The “Configuration” menu item displays the “Radio Channel Configuration” scroll list.

The “Radio Channel Configuration” scroll list has the following columns for identifying 
radio channels.

Name - the names of the channels

When you select the desired radio channel, the “EDIT” button becomes active.

Figure 4-21: Radio Channel Configuration Scroll List
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Buttons

ADD RADIO 5 TO 8

The “ADD RADIO 5 TO 8” button on the “Radio Channel Configuration” screen allows you 
to automatically add radio channels 5 to 8 to the system. When selected, a dialog box 
appears asking if you wish to proceed. 

EDIT

The “EDIT” button on the “Radio Channel Configuration” screen allows you to change the 
settings for a radio channel.

When you select “EDIT”, a screen appears allowing you to set the parameters for the 
channel.

Figure 4-22: Add Radio 5 to 8 Warning Dialog Box

Figure 4-23: First Edit Radio Channel Screen
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Buttons

NEXT

Select the “NEXT” button (or press [Page Down]) to display the second “Edit Radio Chan-
nel” screen.

PREVIOUS

Select the “PREVIOUS” button (or press [Page Up]) to return to the first “Edit Radio Chan-
nel” screen.

Fields

Name

The “Name” field allows you to change the name of the radio channel. The “Name” field is 
actually two fields. The two fields allow you to name the channel with two 8 character 
words. At least one of the fields must contain data and a name cannot be duplicated.

Mode

The “Mode” field allows you to specify whether a channel is capable of:

• Receiving and transmitting (RX-TX)

Call detection method

The “Call detection method” field allows you to specify the type of method used by the 
channel to tell whether a call is coming in on the channel. The following call detection 
methods are possible:

• Voice detect - the channel detects speech on the line and then indicates the call in the 
system.

• Carrier Operated Relay detection (COR detect) - The channel detects the line’s carrier 
through an opto-coupler input and then indicates the call in the system.

See also “Signaling method” on page 4-33.

Figure 4-24: Second Edit Radio Channel Screen
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High speed mute

The “High speed mute” field allows you to enable or disable the high speed mute feature 
for this channel. The high speed mute feature mutes audio when an external data decoder 
closes a data detection relay. This muting is “high speed” because data transmission only 
lasts for a very short period of time. 

If the call detection is set to COR, the “High speed mute” field is not available (N/A).

Note: High speed mute does not need to be specified for STAT-ALERT channels, the sys-
tem will automatically mute the STAT-ALERT data burst.

Voice encryption

The “Voice encryption” field allows you to specify the location for the opto-coupler and the 
relay controlling DES/DVP voice encryption on this channel. For the CSDM Lite, the 
default is that the relays and optos are coming from the I/O box only.

Main/standby relay

The “Main/standby relay” identifies the location and the settings for the relays that allow 
you to switch between main and standby channels. “RX+”, “RX-”, “TX+”, “TX-”, etc. refer to 
the relays for each of the wires that are used to receive and transmit through the main and 
standby channels. For the CSDM Lite, configuration of a Main/Standby relay is only 
through an I/O box.

First auxiliary I/O

The “First auxiliary I/O” field allows you to specify which auxiliary I/O is assigned to the 
“Aux1 I/O” button on the CCM assigned to this channel. For the CSDM Lite, configuration 
is only through an I/O box. Refer to the Auxiliary I/O section in this chapter for more infor-
mation on how to assign an Aux I/O to a button.

Note: On DCCM modules for Aux1 and Aux2, only the I/O types A and B are supported.

Second auxiliary I/O

The “Second auxiliary I/O” field allows you to specify which auxiliary I/O is assigned to the 
“Aux2 I/O” button on the CCM assigned to this channel. For the CSDM Lite, configuration 
is only through an I/O box. Refer to the Auxiliary I/O section in this chapter for more infor-
mation on how to assign an Aux I/O to a button.

Note: On DCCM modules for Aux1 and Aux2, only the I/O types A and B are supported.

Parallel Status

The “Parallel Status” field allows you to set the parallel status on or off and is only avail-
able in Tone Control Signalling mode. When set to ON, the channel will decode other con-
sole change of functions (for example, F1 to F2).

TX Voice Delay

The “TX Voice Delay” field allows you to enable or disable a delay in the voice transmis-
sion. When enabled, a value for the delay in milliseconds may be entered.

Num. wires

The “Num. wires” field allows you to specify the configuration for the base station inter-
face. The choices are:
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• 2W half duplex

• 4W half duplex

• 4W full duplex

Location

The “Location” field allows you to specify the port through which the channel is connected 
to the system. This field is configured automatically with the port number.

Repeater

The “Repeater” field allows you to specify the type of repeat function for the channel. 
Choices are:

• None - no repeater is being used for the channel

• Local - the repeat function is performed at the console

• Remote - the repeat function is performed at the base station

For the CSDM Lite, configuration of a Repeat Relay is only through an I/O box.

Channel relay

The “Channel relay” field allows you to specify the relay operation options. A PTT relay 
can be used to key the channel if the transmitter is located very close to the console or just 
to provide a relay closure when transmitting over the channel for other purposes. Choices 
are:

• PTT Disable - the PTT relay is disabled

• PTT Enable - the PTT relay is enabled

When the “Signaling method” field is set to Digital, the following additional choices appear. 
These options are only for the Astro and iDEN radios when an emergency is coming from 
a mobile or portable radio:

• EmerWTimer - the PTT relay closes for a maximum of 5 seconds when a message is 
received and opens again after timing out. If another message is received from the 
radio during the 5 second interval, the PTT relay opens.

• EmerWMsg - the PTT relay closes when a message on is received and opens when a 
message off is received from the radio.

See also “Signaling method” on page 4-33.

Remote repeat disable

The “Remote repeat disable” field allows you to specify the method used to disable the 
remote repeat function if the repeat function is set to “Remote” in the “Repeater” field. 
Choices are:

• Relay only - remote repeat is disabled through the use of a relay.

• Signaling - remote repeat is disabled through the use of a tone or current.

• Sign and Relay - remote repeat is disabled through the use of a relay and a tone or 
current.
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Repeat disable relay

The “Repeat disable relay” field allows you to specify the location and settings for the 
remote repeat disable relay. The “Repeat disable relay” field displays the default ADD 
value. Configuration of a Repeat Relay is only through an I/O box, therefore, the console 
must be equipped with an I/O box.

If the “Remote repeat disable” field is set to Signaling, the “Repeat disable relay” field is 
not available (N/A).

RX multi-frequency

The “RX multi-frequency” field allows you to specify the number of receive frequencies 
available for the channel. The maximum is 16 frequencies.

The number of frequencies available to select here is set in the RX freq. field of the Edit 
Tone Signaling Plan Screen (page 4-48) or RX frequencies of the Edit DC Signaling Plan 
Screen (page 4-51).

TX multi-frequency

The “TX multi-frequency” field allows you to specify the number of transmit frequencies 
available for the channel. The maximum is 16 frequencies.

The number of frequencies available to select here is set in the TX freq. field of the Edit 
Tone Signaling Plan Screen (page 4-48) or TX frequencies of the Edit DC Signaling Plan 
Screen (page 4-51).

Signaling method

The “Signaling method” field allows you to specify the type of signaling for the channel. 
Choices are: Tone, DC, Tone + DC, Mobile, and None. Mobile radio is not available for 
channels 7 and 8.

Note: E&M (Ear & Mouth) signaling is possible for any Signaling method whenever you 
enable COR detect in the Call detection method field (E) and PTT Enable in the Channel 
relay field (M), even if you select None as the Signaling method. Select None in the Sig-
naling method field if you do not want either DC or Tone.

Parallel unit

The “Parallel unit” field allows you to specify how a Parallel unit will interface to the chan-
nel. Choices are:

• Off - Parallel unit keying is not detected.

• On - Parallel unit intercom and transmit audio is heard in the console; Parallel unit 
keying busies out the channel.

• X-muted - Parallel unit intercom audio only is heard in the console; Parallel unit keying 
busies out the channel.

Caller ID format

The “Caller ID format” field allows you to specify the caller ID for the channel. Choices are: 
None, STAT-ALERT, and DTMF.
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Talk Permit

The “Talk Permit” field allows you to enable or disable talk permit. With the “Talk Permit” 
field enabled, the “Talk Permit Settings” field may be edited. For the “Talk Permit” field to 
be active, the “Num. wires” field must be set to 4W full duplex.

DTMF Selective call

The “DTMF Selective call” field allows you to specify whether DTMF Selective call is 
enabled or disabled for the channel. If either the “DTMF Selective call” field is enabled, or 
the “Caller ID format” field is set to DTMF, the “DTMF decode settings” field may be edited.

If the “Caller ID format” field is set to DTMF, the “DTMF Selective call” field is not available 
(N/A).

Recorder level

The “Recorder level” field allows you to specify the gain at which the channel will be pre-
sented to the recorder port. Valid values are from -60dBm to +11dBm.

Muting level

The “Muting level” field allows you to specify the muting level for the channel. Choices are:

• Muted - there is no audio from this channel when the mute button is pressed.

• Audible - the audio volume from this channel is lowered by 24dB when the mute but-
ton is pressed. 

Unselect speaker

The “Unselect speaker” field allows you to specify the unselect speaker you want the 
channel to be heard on.

Tone signaling plan

The “Tone signaling plan” field allows you to specify the tone signaling plan for the chan-
nel. This field is active only if the “Signaling method” field is set to “Tone” or “Tone+DC”.

DC signaling plan

The “DC signaling plan” field allows you to specify the DC signaling plan for the channel. 
This field is active only if the “Signaling method” field is set to “DC” or “Tone+DC”.

Mobile Radio Type

The “Mobile Radio Type” field allows you to select the type of radio for the channel. This 
field is active only if the “Signaling method” field is set to “Mobile”.

PL strip supported

The “PL strip supported” field allows you to specify whether PL strip is enabled or disabled 
for the channel. 

If two separate groups must use the same frequency, private line (PL) tones can accom-
pany transmitted audio and ensure that the transmission is only picked up by the intended 
group.

When “PL strip supported” is enabled, the private line (PL) tones that are ordinarily sent 
with transmitted audio are not sent on the channel if the channel is used for paging. As a 
4-34 CommandSTAR Lite System Database Manager Manual
(6880309K01-C — July 11 2003)



Configuration Menu
Radio Channel
result, pagers (which do not require PL tones) will pick up the page signal while radio 
receivers (which do require PL tones) will not.

Number of PL/DPL

The “Number of PL/DPL” field allows you to specify the number of PL tones or DPL tones 
(Private Line tones or Digital Private Line tones) assigned to the channel.

Wildcard frequencies

The “Wildcard frequencies” field allows you to specify the number of wildcard tone 
sequences to be used with the channel. 

A “Wildcard” can be used to operate miscellaneous devices and is operated by pressing 
the wildcard button on the channel’s CCM. A wildcard has two frequencies. The first fre-
quency, used to turn the device on, is sent when the wildcard button is pressed. The sec-
ond frequency, used to turn the device off, is sent when the wildcard button is pressed 
again. Each tone signaling plan can have up to two wildcard frequencies. 

The “Wildcard frequencies” field can have the following values:

• 0 - no wildcard

• 1 - one wildcard which is operated by the “WldCard1” button on the channel’s CCM.

• 2 - two wildcards, the first of which is operated by the “WldCard1” button on the chan-
nel’s CCM, the second of which is operated by the “WldCard2” button on the channel’s 
CCM.

STAT-ALERT settings

The “STAT-ALERT settings” field allows you to set the parameters for the STAT-ALERT 
caller ID format. If the “Caller ID format” field is not set to STAT-ALERT, the “STAT-ALERT 
settings” field is not available (N/A). The “STAT-ALERT settings” field displays the “STAT-
ALERT Configuration” screen.

The “STAT-ALERT Configuration” screen has the following fields:

PTT ID Type - The PTT ID is data that identifies the console keying the channel. “PTT ID 
Type” field can have the following values:

Figure 4-25: STAT-ALERT Configuration Screen
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• None - no PTT ID is used on the channel

• Leading - the PTT ID is sent when the PTT button is pressed.

• Trailing - the PTT ID is sent when the PTT button is released.

Leading pretime - The leading pretime is the time delay between the time the PTT button 
is pressed (or the time the RAC code ends) and the time the PTT ID is sent (see Figure 4-
21). Values can range from 0 to 60000 milliseconds.

Trailing pretime - The trailing pretime is the time delay between the time the PTT button 
is released and the time the PTT ID is sent. Values can range from 0 to 60000 millisec-
onds.

Pretime type - The “pretime type” field can have the following values:

• Silent - During the leading pretime, no data nor tones are sent.

• Bit sync - During the leading pretime, the bit sync sequence of the STAT-ALERT mes-
sage is sent. This gives the receivers more opportunity to synchronize with the trans-
mitter.

RAC type - The Remote Access Code (RAC) is a code sent to activate a specific remote 
repeater. When used, the RAC is sent before the leading pretime. The “RAC type” field 
can have the following values:

• No RAC - No RAC is used on the channel.

• Manual RAC - The RAC has to be sent manually (using a manual page button that 
has been assigned the “STAT-ALERT” format and the “manual RAC” type) before the 
PTT button is pressed.

• Auto RAC - The RAC is sent when the PTT button is pressed.

Default RAC - The “Default RAC” field allows you to specify the RAC that will be sent 
when the RAC type field is set to “Auto RAC”.
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RAC pretime - The RAC pretime is the time delay between the time the PTT button is 
released and the time the RAC is sent (see Figure 4-21). Values can range from 0 to 
60000 ms.

Mute monitor - The “mute monitor” field allows you to enable or disable the mute monitor 
feature. When enabled, the mute monitor feature detects when the channel is “muted” (not 
being used).

The mute monitor feature is useful if the channel is using PL tones. PL tones prevent spe-
cific groups from receiving on the channel, yet allow those groups to transmit. Hence the 
potential exists for conflicting transmissions. If members of an excluded group wish to use 
the channel for paging, they can go through the motions of sending a page, but the con-
sole waits until the channel is “muted” (not being used) before the page is actually sent. 
After sending the page the console waits for acknowledgment. If the page is not acknowl-
edged within a certain period of time the console sends the page again.

Retry constant - The retry constant can be a number from 2 to 17. This number is used in 
a software equation to determine the length of time the console should wait before trying 
to send the page again after not receiving an acknowledgment. The higher the number the 
longer the delay. (Please see the explanation for “mute monitor”.) 

Limited patience - The “Limited patience” field allows you to specify a period of time after 
which the console ignores the mute monitor and transmits whether the channel is free or 
not. Values for this field can range from 0 to 60 seconds. A value of 0 (zero) means con-
sole will never ignore the mute monitor. (Please see the explanation for “mute monitor”.)

Busy timer - The “Busy timer” field allows you to enable or disable the busy timer func-
tion. 

If two consoles are using mute monitor to monitor the same channel, and both consoles 
are waiting to send pages, as soon as the channel is available the pages will be sent at the 
same time resulting in a both messages being garbled. When the “Busy timer” field is 
enabled, the pages are less likely to collide and become garbled because each page must 
wait a randomly generated period of time before it can be sent. (Please see the explana-
tion for “mute monitor”.)

Figure 4-26: The PTT is followed by the RAC pretime, the RAC, the leading pretime, 
and the PTT ID.
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DOS coast - The “Data Operated Squelch (DOS) coast” field allows you to specify the 
length of time for the DOS coast. Values can range from 0 to 60000 ms.

Data Operated Squelch (DOS) coast is a muting of the channel during the portion of the 
message between data and speech. 

DTMF decode settings

The “DTMF decode settings” field allows you to set the parameters for the DTMF caller ID 
format and the DTMF Selective call. If the “Caller ID format” field is not set to DTMF and 
the “DTMF Selective call” field is not enabled, the “DTMF decode settings” field is not 
available (N/A). The “DTMF decode settings” field displays the “DTMF Decode Settings” 
screen.

The “DTMF Decode Settings” screen has the following fields:

Minimum DTMF digits - The minimum number of DTMF digits for decode can be from 
1 to 7. Only the decodes that are within the minimum and maximum value set are dis-
played and sent to the logging printer.

Maximum DTMF digits - The maximum number of DTMF digits for decode can be from 
2 to 8. Only the decodes that are within the minimum and maximum value set are dis-
played and sent to the logging printer.

DTMF digit duration - The time for one DTMF digit.

Interdigit duration - The time between DTMF digits.

Last digit waiting time - The maximum time to wait for the next digit before decoder 
reset.

Talk Permit Settings

The “Talk Permit Settings” field allows you to set the parameters for the Go-ahead tones. If 
the “Num. wires” field is not set to 4W full duplex and the “Talk Permit” field not enabled 
(no check mark), the “Talk Permit Settings” field is not available (N/A). Also, the “Signaling 

Figure 4-27: DTMF Decode Settings Screen
4-38 CommandSTAR Lite System Database Manager Manual
(6880309K01-C — July 11 2003)



Configuration Menu
Radio Channel
method” field must NOT be set to Digital. The “Talk Permit Settings” field displays the “Talk 
Permit Configuration” screen.

The “Talk Permit Configuration” screen has the following fields:

Tone Frequency - Enter the radio Go-ahead Tone Burst Frequency that needs to be 
detected. Valid values are from 200 Hz to 3400 Hz.

Min Tone Duration - Enter the Min Duration of radio Tone Bursts. Valid values are from 0 
ms to 1000 ms.

Min Pause Duration - Enter the Min Pause Duration between the radio Tone Bursts. Valid 
values are from 0 ms to 1000 ms.

Number of Tones - Enter the number of radio Tone Bursts. Valid values are from 0 to 5.

Time Out - Enter the time which the console will wait for the reception of the Go-ahead 
Tones. Valid values are from 0 ms to 10000 ms.

TX level

The “TX level” field allows you to specify the transmit level for the channel. Values can 
range from -60dBm to +11dBm.

Note: When setting up a console to be used with a Digital Junction Box (L3208, L3239), 
be sure to set the TX level to -20dBm.

RX level

The “RX level” field allows you to specify the receive level for the channel. Values can 
range from -60dBm to +11dBm. This is the overall gain for audio reception. Set this value 
to be the same as the level of the audio coming in from the radio.

RX detect threshold

The “RX detect threshold” field allows you to specify the level below which the receive 
audio will not be accepted through the port and hence will not be heard. Values can range 
from -5dB to -32dB in 3dB increments and is relative to the RX level. RX detect threshold 
works in combination with RX level to specify the lowest level of audio that the console 
detects. Set this value so that the console can still pick up the human voice when it falls 
below the average loudness for human conversation.

Figure 4-28: Talk Permit Configuration Screen
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RX hangover delay

The “RX hangover delay” field allows you to specify the RX hangover delay. The RX hang-
over delay is a period of time after incoming audio has stopped that the system will con-
sider that the channel is still in use. When the hangover delay period runs out, the call light 
on the console goes out. Values can range from 250 to 30000 ms. Set this value so that 
the channel is not released every time there is a pause in conversation. For half-duplex 
systems, set this value so that the channel is released for reply without too long a wait.

Priority marker

The “Priority marker” field enables or disables the priority marker on the channel. The pri-
ority marker is a 700Hz tone transmitted on the channel every ten seconds used to warn 
users that this channel is reserved for emergencies.

RX impedance

The “RX impedance” field allows you to select an impedance of 600 or 10K Ohms.

TX Timeout

The “TX Timeout” field allows you to set the maximum duration (10 to 60 seconds) of a 
transmission.
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Assignment

The “Assignment” menu item allows you to specify which channels will be assigned to 
which operator modules. 

The “Assignment” menu item displays the “Radio Assignment to Operator Module” matrix.

To assign a channel to an operator module: 

1. If no matrix elements are currently selected, select the matrix elements that corre-
spond to the desired channel and operator module combinations. 

Note that a row can only contain one “X”. If you wish to change the current settings, 
you must first disable the current settings, then select the matrix elements that corre-
spond to the desired channel and operator module combinations.

When enabled, a matrix element contains an “X”.

When disabled, a matrix element contains a rectangle.

2. Select “OK”.

You are returned to the “Radio Channel” submenu.

Cross-Muting

If two radio channels interfere with one another, the audio from the keyed channel can 
crossover onto the interfering channel and be heard on the transmitting console’s speaker. 
The audio from the speaker can be picked up by the transmitting microphone and cause 
feedback. 

The cross-mute feature lets you mute the audio of the interfering channel so it will not be 
heard on the speaker when the other channel is keyed.

Figure 4-29: Radio Assignment to Operator Module Matrix Screen
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The “Cross-Muting” menu item displays the “Radio Channel Cross-Muting” matrix.

To enable cross-mute between two channels:

1. Select the matrix element that corresponds to the two channels you wish to cross-
mute.

The rectangle changes to an “X”.

2. Select “OK”.

You are returned to the “Radio Channel” submenu.

To set the radio channel cross-mute level:

Select the “General” menu item in the “Configuration” menu and then select the “radio 
channel” field under the heading “Cross-mute attenuation level”.

The cross-mute feature can be set to one of two levels. The level you choose is system 
wide, that is, it is applied to all the cross-muted channels in the system. The levels are:

• Audible - lowers audio by 24 dB

• Muted - totally muted

Tone Signaling

Consoles send signaling tones to base stations to tell the base stations to perform specific 
functions. 

A tone signaling plan is a grouping of tone definitions in which the frequencies and gain 
levels of commonly used signaling tones are defined. 

Figure 4-30: Radio Channel Cross-Muting Matrix
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The “Tone Signaling” menu item displays the “Tone Signaling Plan Configuration” screen.

When you select a plan from the “Tone Signaling Plan Configuration” screen, the COPY, 
EDIT, and DELETE buttons become active. The default tone signaling plan cannot be 
edited.

Buttons

NEW

The “NEW” button on the “Tone Signaling Plan Configuration” screen allows you to create 
a new tone signaling plan.

COPY

The “COPY” button on the “Tone Signaling Plan Configuration” screen allows you to copy 
the settings of the selected tone signaling plan and save them as a new tone signaling 
plan.

DELETE

The “DELETE” button on the “Tone Signaling Plan Configuration” screen allows you to 
delete the selected tone signaling plan.

EDIT

The “EDIT” button on the “Tone Signaling Plan Configuration” screen allows you to change 
the settings of an existing tone signaling plan.

Figure 4-31: Tone Signaling Plan Configuration Screen
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When you select “NEW”, “COPY” or “EDIT” from the “Tone Signaling Plan Configuration” 
screen, the “Edit Tone Signaling Plan” screen appears allowing you to set the parameters 
for the tone.

Buttons

TRANSMIT

The “TRANSMIT” button displays the “TX Frequencies” screen.

The “TX Frequencies” screen has two types of field:

TX freq. - The “TX freq.” field allows you to specify the frequencies of TX frequency signal-
ing tones. A TX frequency signaling tone tells a base station to transmit on a specific fre-
quency. Values can range from 200Hz to 3400Hz.

Talk Permit - A check mark instructs the system to wait until Talk Permit is received before 
sending MDC signaling or paging tones through the air.

Figure 4-32: Edit Tone Signaling Plan Screen

Figure 4-33: TX Frequencies Screen
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RECEIVE

The “RECEIVE” button displays the “RX Frequencies” screen.

The “RX Frequencies” screen has one type of field:

RX freq. - The “RX freq.” field allows you to specify the frequencies of RX frequency sig-
naling tones. An RX frequency signaling tone tells a base station to receive on a specific 
frequency. Values can range from 200Hz to 3400Hz.

WILDCARDS

The “WILDCARDS” button displays the “Wildcard Frequencies” screen.

The “Wildcard Frequencies” screen has the following fields:

Wildcard freq. On - The “Wildcard freq. On” field allows you to specify Wildcard signaling 
tone frequencies for turning devices on at a base station. Values can range from 200Hz to 
3400Hz.

Wildcard freq. Off - The “Wildcard freq. Off” field allows you to specify Wildcard signaling 
tone frequencies for turning devices off at a base station. Values can range from 200Hz to 
3400Hz.

Figure 4-34: RX Frequencies Screen

Figure 4-35: Wildcard Frequencies Screen
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PL/DPL (Private Line/Digital Private Line) 

The “PL/DPL” button displays the “PL/DPL Frequencies” screen.

The “PL/DPL Frequencies” screen has the following field:

PL/DPL freq. - The “freq.” field allows you to specify PL/DPL signaling tone frequencies. 
The PL/DPL frequency signaling tone tells the base station to use a specific PL/DPL 
group. Values can range from 200Hz to 3400Hz.

Fields

Tone plan ID

The “Tone plan ID” field allows you to select the name for the tone signaling plan. Names 
can range from Tone 1 to Tone 31, plus default.

Secure tone gain

The “Secure tone gain” field allows you to set the gain level for the Secure tone. The level 
is relative to the channel TX level. Values can range from -40dB to 11dB.

Hold tone gain

The “Hold tone gain” field allows you to set the gain level for the Hold tone. The level is rel-
ative to the channel TX level. Values can range from -40dB to 11dB.

Function tone gain

The “Function tone gain” field allows you to set the gain level for the Function tone. The 
level is relative to the channel TX level. Values can range from -40dB to 11dB.

Secure & hold tone

The “Secure & hold tone” field allows you to set the frequency for the Secure & hold tone.

Secure tone duration

The “Secure tone duration” field allows you to set the duration for the Secure tone. Values 
can range from 0ms to 60,000ms.

Function tone duration

The “Function tone duration” field allows you to set the duration for the Function tone. Val-
ues can range from 0ms to 60,000ms.

Figure 4-36: PL/DPL Frequencies Screen
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Inter function delay

The “Inter function delay” field allows you to set the duration for the Inter function delay, a 
time period between two successive signaling tones. Values can range from 0ms to 
60,000ms.

Repeater supported

The “Repeater supported” field allows you to specify whether or not a Repeater is sup-
ported at the base station.

Repeater enable freq. 

The “Repeater enable freq.” field allows you to set the frequency to enable the repeater 
function. Values can range from 200Hz to 3400Hz.

Repeater disable freq. 

The “Repeater disable freq.” field allows you to set the frequency to disable the repeater 
function. Values can range from 200Hz to 3400Hz.

Encryption Supported

The “Encryption Supported” field allows you to specify whether or not DES/DVP Encryp-
tion is supported at the base station.

Coded

The “Coded” field allows you to set the frequency to enable the encryption of a transmis-
sion. Values can range from 200Hz to 3400Hz.

Clear

The “Clear” field allows you to set the frequency to disable the encryption of a transmis-
sion. Values can range from 200Hz to 3400Hz.

PL strip supported

The “PL strip supported” field allows you to specify whether or not PL strip is supported at 
the base station.

PL strip freq. 

The “PL strip freq.” field allows you to set the frequency to enable PL strip. Values can 
range from 200Hz to 3400Hz.

Monitoring

The “Monitoring” field allows you to set controls for channel Monitoring. Choices are: 
• disabled - Monitoring can be disabled
• enabled and disabled - Monitoring can be enabled and disabled.
• none - monitoring is not supported

Disable freq. 

The “Disable freq.” field allows you to set the frequency to disable Monitoring. Values can 
range from 200Hz to 3400Hz.

Enable freq. 

The “Enable freq.” field allows you to set the frequency to enable Monitoring. Values can 
range from 200Hz to 3400Hz.
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TX freq. 

The “TX freq.” field allows you to specify the number of transmit frequencies supported by 
the tone signaling plan. The maximum is 16.

Note: Select the drop down list arrow to change the number of frequencies. The number 
of frequencies set here determines the number of frequencies available in the First Edit 
Radio Channel Screen for “TX multi-frequency” on page 4-33.

RX freq. 

The “RX freq.” field allows you to specify the number of receive frequencies supported by 
the tone signaling plan. The maximum is 16.

Note: Select the drop down list arrow to change the number of frequencies. The number 
of frequencies set here determines the number of frequencies available in the First Edit 
Radio Channel Screen for “RX multi-frequency” on page 4-33.

Wildcard freq. 

The “Wildcard freq.” field allows you to specify the number of Wildcard frequencies sup-
ported by the tone signaling plan. The maximum is 2.

PL/DPL freq. 

The “PL/DPL freq.” field allows you to specify the number of PL/DPL frequencies sup-
ported by the tone signaling plan. The maximum is 8.

DC Signaling

Consoles send specific DC currents to base stations to tell the base stations to perform 
specific functions. 

A DC signaling plan is a group of DC currents used for signaling.

The “DC Signaling” menu item displays the “DC Signaling Plan Configuration” screen.

When you select a plan from the “DC Signaling Plan Configuration” screen, the COPY, 
EDIT, and DELETE buttons become active. The default DC signaling plan cannot be 
edited.

Figure 4-37: DC Signaling Plan Configuration Screen
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Buttons

NEW

The “NEW” button on the “DC Signaling Plan Configuration” screen allows you to create a 
new DC signaling plan.

COPY

The “COPY” button on the “DC Signaling Plan Configuration” screen allows you to copy 
the settings of the selected DC signaling plan and save them as a new DC signaling plan.

DELETE

The “DELETE” button on the “DC Signaling Plan Configuration” screen allows you to 
delete the selected DC signaling plan.

EDIT

The “EDIT” button on the “DC Signaling Plan Configuration” screen allows you to change 
the settings of an existing DC signaling plan.

When you select “NEW”, “COPY”, or “EDIT” from the “DC Signaling Plan Configuration” 
screen, the “Edit DC Signaling Plan” screen appears allowing you to set the parameters 
for the signal.

Buttons

TX FREQ

The “TX FREQ” button displays the “TX Frequencies” screen.

Figure 4-38: Edit DC Signaling Plan Screen

Figure 4-39: TX Frequencies Screen
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The “TX Frequencies” screen has the following fields:

TX freq. 1 and 2 - field allows you to specify the TX frequency DC current. A TX frequency 
DC current tells a base station to transmit on a specific frequency.

RX FREQ

The “RX FREQ” button displays the “RX Frequencies” screen.

The “RX Frequencies” screen has the following fields:

“No monitoring” - the base station will allow a dispatcher to receive the specified frequency 
and the frequency will not be monitored.

“Monitoring” - the base station will allow a dispatcher to receive the specified frequency 
and the frequency will be monitored.

“Repeater Enabled” - these currents enable the repeater.

“Repeater Disabled” - these currents disable the repeater.

RX freq. - These fields allow you to specify DC signaling current for RX frequencies. A DC 
signaling current for RX frequencies tells a base station to receive on a specific frequency.

Fields

DC plan ID

The “DC plan ID” field allows you to select the name for the DC signaling plan. Names can 
range from DC 1 to DC 31, plus default.

Repeater supported

The “Repeater supported” field allows you to specify whether or not a Repeater is sup-
ported at the base station.

Monitor supported 

The “Monitor supported” field allows you to specify whether or not the Monitor feature is 
supported at the base station.

Figure 4-40: RX Frequencies Screen
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PL strip supported

The “PL strip supported” field allows you to specify whether or not the PL strip feature is 
supported at the base station

PL strip curr. 

The “PL strip curr.” field allows you to specify DC signaling current for the PL strip feature.

TX frequencies

The “TX frequencies” field allows you to specify the number of transmit frequencies sup-
ported by the DC signaling plan. The maximum is 2.

Note: Select the drop down list arrow to change the number of frequencies. The number 
of frequencies set here determines the number of frequencies available in the First Edit 
Radio Channel Screen for “TX multi-frequency” on page 4-33.

RX frequencies

The “RX frequencies” field allows you to specify the number of receive frequencies sup-
ported by the DC signaling plan. The maximum is 2.

Note: Select the drop down list arrow to change the number of frequencies. The number 
of frequencies set here determines the number of frequencies available in the First Edit 
Radio Channel Screen for “RX multi-frequency” on page 4-33.

Caller ID List

The “Caller ID List” menu item allows you to add and edit the parameters of caller IDs. The 
caller ID feature is used to identify the calling party. When a person with a caller ID keys a 
channel, that person’s ID is received by a console and used to extract the persons alias 
(name) from the caller ID database. The alias is then displayed at the console and the dis-
patcher knows who is making the call. If no alias is defined, the ID is displayed at the con-
sole.

The “Caller ID List” menu item displays the “Caller ID List” scroll list.

Figure 4-41: Caller ID List Scroll List
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The “Caller ID List” scroll list has the following columns:

Alias - identifies the alias (usually the caller’s name)

ID - identifies the ID number associated with the alias

Type - identifies the type of protocol being used

Radio Channel - identifies which channel associated with the alias

When you select the desired alias, the DELETE and EDIT buttons become active.

Buttons

ADD

Select the “ADD” button to display the “Add Alias” screen and add an alias.

DELETE

Select the “DELETE” button to delete the selected alias.

EDIT

Select the “EDIT” button to display the “Edit Alias” screen and edit the selected alias.

DELETE ALL

Select the “DELETE ALL” button to delete all the aliases.

Figure 4-42: Add Alias Screen 

Figure 4-43: Edit Alias Screen
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SAVE TO DISK

Select the “SAVE TO DISK” button to save the Caller ID Alias to the disk in the CSDM Lite 
directory. The file name “CallerID.txt” is created.

LOAD FROM DISK

Select the “LOAD FROM DISK” button to load the Caller ID Alias from the CDSM Lite 
directory on the disk.

Fields

Alias

The “Alias” field allows you to specify the caller’s alias (name). The “Alias” field is actually 
two fields. The two fields allow you to name the “Alias” with two 8 character words. At least 
one of the fields must contain data and a name cannot be duplicated.

Type

The “Type” field allows you to specify the signaling protocol used by the caller. Choices 
are:

• MDC Unit - which uses the STAT-ALERT protocol

• Status - which uses the STAT-ALERT protocol and signifies that the caller is sending a 
status message.

• Message - which uses the STAT-ALERT protocol and signifies that the caller is send-
ing a message.

• DTMF - unit ID which uses the standard DTMF frequencies.

ID

The “ID” field allows you to specify the identification number for the alias.

For STAT-ALERT, values can range from 0 to D for the most significant digit and 0 to E for 
the other digits. 0000 is not allowed.

For Status and Message, values can range from 0000 to 0255. 

For DTMF types, values can range from 00000000 to 99999999.

Radio channel

The “Radio channel” field allows you to specify the radio channel(s) associated with the 
alias.
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Phone Line

The “Phone line” menu item displays the “Phone Line Configuration” scroll list.

When you select the desired phone line, the “EDIT” button becomes active.

Buttons

EDIT

The “EDIT” button allows you to set the parameters of the selected phone line.

Note: Phone lines, “Line 1” and “Line 2”, are assigned automatically when the user 
enables the CO Line module in the “Phone Line Configuration” menu.

When you select “EDIT” from the “Phone Line Configuration” screen, the “Edit Phone 
Line” screen appears allowing you to set the parameters for the phone line.

Fields

Name

The “Name” field allows you to name the phone line or change the name of the phone line. 
This field cannot be left blank nor can it be duplicated.

Figure 4-44: Phone Line Configuration Scroll List

Figure 4-45: Edit Phone Line Screen
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Dialing mode

The “Dialing mode” field allows you to specify the dialing mode for the phone line. Choices 
are:

• DTMF (Dual Tone Multi Frequency)

• Pulse

Hook flash duration

The “Hook flash duration” field allows you to define the duration of the hook flash for the 
phone line. Valid values range from 0ms to 2000ms, with 5ms increments. 
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Paging

The “Paging” menu item displays a sub-menu with the following menu items:

• Custom Page

• Page Format

• External Pager

• Manual Page

• Speed Page

• Paging Aliases

Custom Page

The Custom Page feature, available in the extended paging package, allows you to create 
a page that is not associated with any of the standard paging formats. With the Custom 
Page feature you can define the frequencies, the duration, and the delay between two 
tones. 

The “Custom Page” menu item displays the “Custom Page Configuration” screen.

When you select a page code from the “Custom Page Configuration” screen, the 
“DELETE” and “EDIT” buttons become active.

Buttons

ADD

The “ADD” button allows you to add a new custom page and set its parameters.

DELETE

The “DELETE” button allows you to delete the selected custom page.

Figure 4-46: Custom Page Configuration Screen
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EDIT

The “EDIT” button allows you to set the parameters of the selected custom page.

When you select “ADD” or “EDIT” from the “Custom Page Configuration” screen, the “Add 
Custom Page” or “Edit Custom Page” screen appears allowing you to set the parameters 
for the custom page.

Fields

Code

The “Code” field allows you to specify the custom page code. This is the number a dis-
patcher will use to send a specific custom page. Valid custom page codes can range from 
000 to 999. 

First tone frequency

The “First tone frequency” field allows you to set the frequency of the first tone in the page. 
Valid custom page code frequencies can range from 200 Hz to 3400 Hz.

Caution: If radio channel is tone control, do not use a frequency close to the guard tone 
(2175 Hz default) as the paging tone level will be severely affected.

First tone duration 

The “First tone duration” field allows you to set the duration of the first tone in the page. 
Valid tone durations can range from 0 ms to 10000 ms.

Intertone delay

The “Intertone delay” field allows you to set the duration of the time delay between the two 
tones. Valid tone durations can range from 0 ms to 10000 ms.

Second tone frequency

The “Second tone frequency” field allows you to set the frequency of the second tone in 
the page. Valid custom page code frequencies can range from 200 Hz to 3400 Hz.

Caution: If radio channel is tone control, do not use a frequency close to the guard tone 
(2175 Hz default) as the paging tone level will be severely affected.

Figure 4-47: Add Custom Page Screen
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Second tone duration

The “Second tone duration” field allows you to set the duration of the second tone in the 
page. Valid tone durations can range from 0 ms to 10000 ms.

Inhibit delay

The “Inhibit delay” field allows you to set the time delay between the end of the second 
tone and the time when speech can be transmitted. Valid tone durations can range from 0 
ms to 10000 ms.

PC CSL voice annotation

The “PC CSL voice annotation” field allows you to specify how long the channel will 
remain keyed after the page tone ends in order to send a voice message over the air. The 
value can range from 0 to 60 seconds. This field applies only to the PC console.

Page Format

The “Page Format” menu item allows you to add page formats to the configuration file. 
The “Page Format” menu item also allows you to set parameters for each page format. 

Note: For information on the main page formats please see Appendix B.

The “Page Format” menu item displays the “Page Format Configuration” screen.

When you select a format from the “Page Format Configuration” screen, the “DELETE” 
and “EDIT” buttons become active.

Buttons

ADD

The “ADD” button allows you to add a new page format and set its parameters.

DELETE

The “DELETE” button allows you to delete the selected page format.

Figure 4-48: Page Format Configuration Screen
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EDIT

The “EDIT” button allows you to set the parameters of the selected page format.

When you select “ADD” or “EDIT” from the “Page Format Configuration” screen, the “Add 
Page Format” or “Edit Page Format” screen appears allowing you to set the parameters 
for the page format.

Fields

Name

The “Name” field allows you to name the page format.

Page format

The “Page format” field allows you to select the desired page format. Depending on 
whether the “Paging package” field in the “Configuration/General” menu is set to “Basic” or 
“Extended”, the following paging formats are available:

• Basic:

• Motorola 1+1

• Motorola 2+2

• GE type 99

• DTMF

• STAT-ALERT

• Extended:

• All the paging formats in the Basic package

• Motorola 5 tone

• Motorola 6 tone

Figure 4-49: Edit Page Format Screen
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• NEC 5 tone

• NEC 6 tone

• Reach

• Rotary Pulse

Depending on which paging format is selected, different fields become available for setting 
parameters.

Code plan (Motorola 1+1, Motorola 2+2, GE Type 99) 

The “Code Plan” field allows you to select a code plan for the paging format.

First tone duration (Motorola 1+1, Motorola 2+2, GE Type 99) 

The “First tone duration” field allows you to set the duration of the first tone in the page. 
Valid tone durations can range from 0 ms to 10000 ms.

Second tone duration (Motorola 1+1, Motorola 2+2, GE Type 99) 

The “Second tone duration” field allows you to set the duration of the second tone in the 
page. Valid tone durations can range from 0 ms to 10000 ms.

Intertone delay (Motorola 1+1, Motorola 2+2, GE Type 99, DTMF) 

The “Intertone delay” field allows you to set the duration of the time delay between the two 
tones. Valid tone durations can range from 0 ms to 1000 ms.

Inhibit delay (Motorola 1+1, Motorola 2+2, GE Type 99, DTMF) 

The “Inhibit delay” field allows you to set the time delay between the end of the second 
tone and the time when speech can be transmitted. Valid tone durations can range from 0 
ms to 10000 ms.

Group call duration (Motorola 1+1, Motorola 2+2) 

The “Group call duration” field allows you to set the duration of a group call tone. Valid 
tone durations can range from 0 ms to 10000 ms.

Tone duration (DTMF, Motorola 5 Tone, Motorola 6 Tone, NEC 5 Tone, NEC 6 
Tone) 

The “Tone duration” field allows you to set the duration of the each tone in the page. Valid 
tone durations can range from 0 ms to 1000 ms.

Type (STAT-ALERT) 

The “Type” field allows you to select a STAT-ALERT type. Choices are:

• Voice alert - This feature allows a dispatcher to send a one time message to a remote 
unit.

• Call alert - This feature allows a dispatcher to send a message to a remote unit. A call 
alert message is evident at the remote unit until the remote unit transmits. When you 
select this feature the “Long call alert” field appears. The “Long call alert” field allows 
you to enable or disable the long call alert protocol.

• Radio check - This feature allows a dispatcher to check if a remote unit is on.
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• Remote monitor - This feature allows a dispatcher to listen through a remote unit. 
When you select this feature the “Silent monitor” and the “Xmit time multiplier” fields 
appear. The “Silent monitor” field allows you to enable or disable the silent monitor 
feature for remote monitoring. The “Xmit time multiplier” field allows you to set the 
number of times the Xmit time is multiplied to extend the duration of remote monitor.

• Radio enable - This feature allows a dispatcher to enable a remote unit.

• Radio disable - This feature allows a dispatcher to disable a remote unit.

• Manual RAC - This feature allows a dispatcher to manually access a repeater.

• Status request - This feature allows a dispatcher to request the vehicle status of a 
remote unit.

• Repeater enable - This feature allows a dispatcher to enable a repeater’s ability to 
handle the STAT-ALERT protocol.

• Repeater disable - This feature allows a dispatcher to disable a repeater’s ability to 
handle the STAT-ALERT protocol.

Preamble (Motorola 5 Tone, Motorola 6 Tone) 

The “Preamble” field allows you to set the preamble tone frequency. Choices are:

• 0 :  600 Hz

• 1 :  741 Hz

• 2 :  882 Hz

• 3 : 1023 Hz

• 4 : 1164 Hz

• 5 : 1305 Hz

• 6 : 1446 Hz

• 7 : 1587 Hz

• 8 : 1728 Hz

• 9 : 1869 Hz

Preamble duration (Motorola 5 tone, Motorola 6 Tone, Nec 5 Tone, Nec 6 Tone) 

The “Preamble duration” field allows you to set the duration of the preamble tone. Valid 
tone durations can range from 0 ms to 1000 ms.

Gap delay (Motorola 5 Tone, Motorola 6 Tone, Nec 5 Tone, Nec 6 Tone) 

The “Gap delay” field allows you to set the duration of the time delay between each tone. 
Valid tone durations can range from 0 ms to 1000 ms.

X tone/gap duration (Motorola 6 Tone, Nec 6 Tone) 

The “X tone/gap duration” field allows you to set the duration of the time delay between 
the last tone and the X tone. Valid tone durations can range from 0 ms to 1000 ms.
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Tone frequency (Rotary Pulse) 

The “Tone frequency” field allows you to set the frequency of the pulse for the rotary pulse 
signaling. Valid rotary pulse tone frequencies can range from 200 Hz to 3400 Hz.

Header duration (Rotary Pulse) 

The “Header duration” field allows you to set the duration of the first tone in a rotary pulse 
signal. Valid tone durations can range from 0 ms to 10000 ms.

Pulse on duration (Rotary Pulse) 

The “Pulse on duration” field allows you to set the duration of the pulse. Valid tone dura-
tions can range from 0 ms to 1000 ms.

Pulse off duration (Rotary Pulse) 

The “Pulse off duration” field allows you to set the duration of the pause between pulses. 
Valid tone durations can range from 0 ms to 1000 ms.

Interdigit duration (Rotary Pulse) 

The “Interdigit duration” field allows you to set the duration of the pause between digits. 
Valid tone durations can range from 0 ms to 10000 ms.

Trailer duration (Rotary Pulse) 

The “Trailer duration” field allows you to set the duration of the last tone in a rotary pulse 
signal. Valid tone durations can range from 0 ms to 10000 ms.

PC CSL voice ann

The “PC CSL voice ann” field allows you to specify how long the channel will remain 
keyed after the page tone ends in order to send a voice message over the air. The value 
can range from 0 to 60 seconds.
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External Pager

The external pager feature allows you to produce paging tones with a device that is exter-
nal to the CommandSTAR Lite system. The external pager tells the console to key the 
channel and to send the tone on a predetermined channel and frequency. 

The “External Pager” menu item allows you to add an external pager to the system, spec-
ify the Input level, the Channel steering, and the Frequency steering of each external 
pager.

The “External Pager” menu item displays the “Edit External Pager” screen.

Fields

Input level

The “Input level” field allows you to specify the input level for the tones received by the 
console from the external pager. Valid values can range from -60 dBm to +11dBm.

Channel steering

The “Channel steering” field allows you to specify the channel(s) on which to send the 
page. Choices are:

• Selected - The page will be sent on the channel that is selected at the console.

• Individual channel - You can a select a single channel on which to send the page.

Frequency steering

The “Frequency steering” field is active when the “Channel steering” field is set to other 
than Selected.

The “Frequency steering” field allows you to specify the frequency on which to send the 
page. Choices are:

• Selected - The page will be sent on the frequency that is selected on the channel.
• Individual frequency - You can a select a single frequency in the channel on which to 

send the page.

Figure 4-50: Edit External Pager Screen
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Ptt

The “Ptt” field on the “Edit External Pager” screen allows you to enable or disable the 
capability to be hooked up with an external pager.

Opto detection

The “Opto detection” field allows you to specify the state of the opto-coupler when it is idle. 

• “Current” means that if current is flowing through the opto-coupler, a Ptt has been 
detected. 

• “No current” means that if no current is flowing through the opto-coupler, a Ptt has 
been detected. 

Debounce time

The “Debounce time” field allows you to specify the debounce time for the opto-coupler. 
Valid values can range from 0 sec to 1000 sec in 5 ms increments.

Manual Page

A dispatcher sends a manual page by pressing a manual page button to specify the page 
format and then keying in a numeric code on the keypad to specify the frequencies to 
send. Please see Appendix B in this manual for Page Code Frequency tables.

In order to have access to the “Manual Page Configuration” scroll list:

• at least one manual page “Man Page” button must be added to the ACM of a console. 
To do this, use the “Configuration/Console/Control Assignment” menu item. 

AND

• at least one paging format must be added to the configuration. To do this, use the 
“Configuration/Paging/Paging Format” menu item.

The “Manual Page” menu item displays the “Manual Page Configuration” scroll list.

Figure 4-51: Manual Page Configuration Scroll List
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The “Manual Page Configuration” scroll list has the following columns.

ACM - The ACM on which the manual page button is located.

ButtonID - The position on the ACM where the button is located.

When you select the desired button, the “Edit Manual Page” screen appears. 

Fields

Page format

The “Page format” field allows you to specify the page format. The choices for the page 
format are defined through the “Paging/Page Format” menu item.

Voice annotation

The “Voice annotation” field allows you to specify how long the channel will remain keyed 
after the page tone ends in order to send a voice message over the air. The value can 
range from 0 to 60 seconds.

Speed Page

A dispatcher sends a speed page by pressing a speed page button. The speed page but-
ton must be associated with a paging alias. A paging alias is a name that is associated 
with a specific tone sequence that will be sent on a specific channel, and at a specific fre-
quency on the channel. To define a paging alias use the “Paging/Paging Alias” menu item. 

In order to have access to the “Speed Page Configuration” scroll list, at least one speed 
page “Speed Pg” button must be added to the ACM of a console. To do this, use the “Con-
figuration/Console/Control Assignment” menu item. 

The Speed Page menu item allows you to specify which alias is associated with which 
speed page button.

Figure 4-52: Edit Manual Page Screen
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The “Speed Page” menu item displays the “Speed Page Configuration” scroll list.

The “Speed Page Configuration” scroll list has the following columns.

ACM - The ACM on which the speed page button is located.

ButtonID - The position on the ACM where the speed page button is located.

Alias - The name of the party who will be paged. A paging alias is a name that is associ-
ated with a specific tone sequence that will be sent on all or specific channels, and at all or 
specific frequencies on those channels.

When you select the desired button, the “Paging Alias Selection” scroll list appears.

Select the desired paging alias. 

You are returned to the “Speed Page Configuration” scroll list.

Figure 4-53: Speed Page Configuration Scroll List

Figure 4-54: Paging Alias Selection Scroll List
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Paging Aliases 

Note: Paging Aliases applies only to the Push Button Console.

A paging alias is a name that is associated with a speed page. 

The “Paging Alias” menu item allows you to specify the name of the person or group who 
will receive the page, the specific tone sequence that will be sent, and the channel and the 
frequency on which the page will be sent. 

In order to have access to the “Paging Aliases Configuration” scroll list, at least one pag-
ing format must be added to the configuration. To do this, use the “Configuration/Paging/
Paging Format” menu item.

The “Paging Aliases” menu item displays the “Paging Aliases Configuration” scroll list.

When you select the desired alias, the DELETE and EDIT buttons become active.

Buttons

ADD

Select the “ADD” button to display the “Add Paging Alias” screen and add a paging alias.

Figure 4-55: Paging Aliases Configuration Scroll List

Figure 4-56: Add Paging Alias Screen
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DELETE

Select the “DELETE” button to delete the selected paging alias.

EDIT

Select the “EDIT” button to display the “Edit Paging Alias” screen and edit the selected 
paging alias.

Fields

Alias name

The “Alias name” field allows you to specify the name of the person or group who will 
receive the page.

Page format

The “Page format” field allows you to specify the page format. The choices for the page 
format are defined through the “Paging/Page format” menu item.

Voice annotation

The “Voice annotation” field allows you to specify how long the channel will remain keyed 
after the page tone ends in order to send a voice message over the air. The value can 
range from 0 to 60 seconds.

Page code

The “Page code” field allows you to specify the paging code that defines the frequencies 
that will be sent. Please see Appendix B of this manual for Page Code Frequency tables.

Channel steering

The “Channel steering” field allows you to specify the channel on which to send the page. 
Choices are:

Selected - The page will be sent on the channel that is selected at the console.

Individual channel - You can select a single channel on which to send the page.

Figure 4-57: Edit Paging Alias Screen
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TX frequency

The “TX frequency” field is active when the “Channel steering” field is set to other than 
Selected.

The “TX frequency” field allows you to specify the frequency on which to send the page. 
Choices are:

• Selected - The page will be sent on the frequency that is selected on the channel.

• Individual frequency - You can a select a single frequency on the channel on which to 
send the page.

Load/Save Paging Aliases List

The “Load/Save Paging Aliases” menu item displays the “Load/Save Paging Aliases List” 
screen.

Buttons

SAVE TO DISK

Select the “SAVE TO DISK” button to save the Paging Alias to disk. The file “Paging.txt” is 
created.

LOAD FROM DISK

Select the “LOAD FROM DISK” button to load the Paging Alias from disk.

Figure 4-58: Load/Save Paging Aliases List Screen
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Auxiliary I/O

The “Auxiliary I/O” menu item displays the “Auxiliary I/O Configuration” screen.

When you select an I/O from the “Auxiliary I/O Configuration” screen, the “DELETE” and 
“EDIT” buttons become active.

Buttons

ADD

The “ADD” button allows you to add a new I/O and set its parameters.

DELETE

The “DELETE” button allows you to delete the selected I/O.

EDIT

The “EDIT” button allows you to set the parameters of the selected I/O.

When you select “ADD” or “EDIT” from the “Auxiliary I/O Configuration” screen, the “Add 
Auxiliary I/O” or “Edit Auxiliary I/O” screen appears, allowing you to set the parameters for 
the I/O. 

Figure 4-59: Auxiliary I/O Configuration Screen

Figure 4-60: Add Auxiliary I/O Screen
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Fields

I/O ID

The “I/O ID” field allows you to select a name for the I/O. Choices are: I/O_1 to I/O_64.

Type

The “Type” field allows you to specify the type of I/O. Choices are: A to H.

Note: To configure a voter site for a Push Button console, you must assign a “C” and an 
“H” I/O. To configure a voter site for a PC Console, you must assign an “I” and a “J” I/O.

Safety button

The “I/O ID” field allows you to enable or disable the safety button feature for this I/O. The 
safety button feature forces the dispatcher to activate the safety button prior to activating 
the I/O button.

Output mode

The “Output mode” field allows you to specify whether the I/O is latching or non-latching.

Table 4-1: Type of I/O

Type Relay Opto Top LED Bottom LED

A 1 to 6 0 On when relay active Off

B 1 to 6 0 On when relay active Off when relay active

C 1 to 6 1 On when relay active On when Input1 active

D 1 to 6 1 On when relay active Blinks when Input1 active

E 0 1 On when Input1 active Off

F 0 1 On when Input1 active Off when Input1 active

G 0 2 On when Input2 active On when Input1 active

H 1 to 6 2 On when Input2 active On when Input1 active

I 1 to 6 2 On when Input2 active On when Input1 active

J 1 to 6 1 On when Input2 active On when Input1 active
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Relays

The “Relays” fields can contain the words “ADD” or “EDIT”. “ADD” allows you to add a 
relay and set its parameters. “EDIT” allows you to change the parameters of an existing 
relay.

When you select ADD or EDIT from the Relays list the “Select Relay for Auxiliary Output” 
screen appears.

The “Select Relay for Auxiliary Output” screen has the following fields.

Console - allows you to select the console on which the relay is located.

I/O Module - (not shown above) allows you to select the I/O module on which the relay is 
located. This field is visible if the “Module location” field is set to “I/O module”.

Module location - allows you to select the module on which the relay is located. Choices 
are: Tower and I/O module.

Output port - allows you to select the output port to which the relay is connected.

Relay idle state - allows you to specify which state, open or closed, will determine if the 
relay is active. 

Figure 4-61: Select Relay for Auxiliary Output Screen
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Optos

The “Optos” fields can contain the words “ADD” or “EDIT”. “ADD” allows you to add an 
opto-coupler and set its parameters. “EDIT” allows you to change the parameters of an 
existing opto-coupler.

When you select ADD or EDIT from the Optos list the “Select Opto for General Input” 
screen appears.

The “Select Opto for General Input” screen has the following fields.

Console - allows you to select the console on which the opto-coupler is located.

I/O Module - (not shown above) allows you to select the I/O module on which the opto-
coupler is located. This field is visible if the “Module location” field is set to “I/O module”.

Module location - allows you to select the module on which the opto-coupler is located. 
Choices are: Tower and I/O module.

Input port - allows you to select the input port on which the opto-coupler is located.

Opto detection - allows you to specify the state of the opto-coupler when it is active.

• “Current” means that if current is flowing, the opto-coupler is active. 

• “No current” means that if no current is flowing, the opto-coupler is active. 

Debounce time - allows you to specify the debounce time for the opto-coupler.

Figure 4-62: Select Opto for General Input Screen
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Alarm

The “Alarm” field allows you to specify an alarm to be associated with the opto-coupler. 
Choices are: none and alarms 1 to 32.

Opto debounce

The “Opto debounce” field identifies the debounce time for the opto-coupler.
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The Diagnostic menu has the following menu items:

• View logs

• Status/Hardware

• Call Event Logging

• Info

• Clear Screen

The “Status/Hardware” submenu is active only when the CSDM Lite is connected to the 
CommandSTAR Lite system. 

View Logs

A log file keeps a record of all the system diagnostics (diagnostics generated by the 
CSDM Lite and the console in the CommandSTAR Lite console) that occur while the 
CSDM Lite is running. Diagnostics are recorded regardless of whether a user is logged in 
or not. The diagnostic messages are also displayed on the CSDM Lite screen. If the 
CSDM Lite is not running, the console stores 100 messages, ready to be sent to the 
CSDM Lite when it starts.

When you start a CSDM Lite for the first time of the day, a new .LOG file is created. The 
name of the file indicates the year, month, and day, (for example - 96_01_28.log) on which 
the file was created. If you log out of the system, then start again, as long as it is on the 
same day, your CSDM Lite session will be registered in the log file of the day. 

Log files are stored in the directory containing the CSDM Lite. If the disk you are using 
becomes full while saving a configuration or receiving new logs from the system, a screen 
appears warning you that your disk is full. While the disk is full, diagnostics are not 
recorded.
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The “View Logs” menu item displays the “View Logs” scroll list.

The “View Logs” scroll list has the following columns.

Log Files - the names of the log files

Size - the sizes of the log files in bytes

When you select the desired log file, the BROWSE and DELETE buttons become active.

Buttons

BROWSE

The “BROWSE” button on the “View Logs” screen displays the selected log file.

Figure 5-1: View Logs Scroll List

Figure 5-2: Typical Log File
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The “SEARCH” button on the log file screen allows you to search for a specified string of 
text.

To search for text:

1. Select the “SEARCH” button.

The “Search for text” screen appears.

2. Type the text you wish to find into the field provided.

3. Select “OK”.

The CSDM Lite searches for and highlights the first occurrence of the specified text.

4. Select the “AGAIN” button to search for the next occurrence of the specified text.

DELETE

The “DELETE” button on the “View Logs” screen deletes the selected log file.

Hardware Status

The “Status/Hardware” menu item is active only when the CSDM Lite is connected to the 
CommandSTAR Lite system.

The “Status/Hardware” menu item allows you to view the status of all the ports on all the 
modules in the console. The port statuses are reported to the CSDM Lite when you open 
the “Hardware Diagnostic” screen and select a peripheral. In order to obtain a “PASSED” 
result, the audio of each channel must be looped back.

Note 1: See Appendix A of the CommandSTAR Lite Installation and Troubleshooting Man-
ual for information on creating a loopback cable.

Note 2: A warning dialogue box appears each time you enter the “Hardware Diagnostic on 
Console” test menu. This is to remind you that a loopback cable is required for each chan-
nel.

Figure 5-3: Search for Text Screen
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Hardware Status
The “Hardware” menu item displays the “Hardware Diagnostic” scroll list.

The “Hardware Diagnostic” scroll list has the following columns:

Console - Identifies the console.

Status - Identifies whether or not the console and its peripherals are working properly.

When you select the console from the “Hardware Diagnostic” scroll list, the “Hardware 
Diagnostic on Console” screen appears. You will be reminded with a warning dialogue box 
to connect the loopback cable for each channel.

The “Hardware Diagnostic” screen allows you to view the status of all the ports or major 
circuits on all the peripherals in the console.

The “Hardware Diagnostic” screen has the following columns:

Module - Identifies the peripheral and each of its circuits.

Status - Identifies whether or not the circuit is working properly.

Passed - Indicates that the circuit is working properly.

Figure 5-4: Hardware Diagnostic Scroll List

Figure 5-5: Hardware Diagnostics Screen - Main Board Selected
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Failed - Indicates that the circuit is not working properly. The following fail messages 
are possible:

• Digital failed (in red text)

• Analog failed

• I/F failed

• Failed

When a failure is indicated, see the Installation and Troubleshooting manual for proce-
dures on how to troubleshoot the problem. 

Time - The port statuses are reported to the CSDM Lite when you open the “Hardware 
Diagnostic” screen and select a peripheral. The time of the reporting is reflected in the 
“time” column.

Button

ACK ALARM

The “Hardware Diagnostic” screen also allows you to acknowledge a system hardware 
failure alarm. 

If the failure has already been rectified, you must press the “ACK ALARM” button to cancel 
both the audible and the visual alarms.

If the failure has not been rectified, pressing the “ACK ALARM” button cancels the audible 
alarm, but the visual alarm continues until the problem has been rectified and the “ACK 
ALARM” button has been pressed again.

Figure 5-6: Hardware Diagnostics Screen - Radio 1 to 4 Selected
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Call Event Logging

The “Call Event Logging” feature allows you to specify:

• whether or not the system has a log printer

• whether the printer is linked to the CSDM Lite or to a console

• the settings for the selected printer

• which logs will be printed

Note: In order for this feature to work, the console’s keypad test #73 must be set to 
“Printer”.

The “Call Event Logging” menu item displays the “Call event logging” screen.

For a typical call event logging printout, refer to Appendix C.

Fields

Radio incoming calls

When this field is enabled, information on incoming radio calls will be printed on the log 
printer. The radio incoming calls log includes information on:

• which channel was used

• when the call was received.

Radio outgoing calls

When this field is enabled, information on outgoing radio calls will be printed on the log 
printer. The radio outgoing calls log includes information on:

• which console sent the call

• which channel was used

• when the call was sent.

Figure 5-7: Call Event Logging Screen
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Radio intercom calls

When this field is enabled, information on intercom radio calls (PA) will be printed on the 
log printer. The radio intercom calls log includes information on:

• which console sent the call

• which channel was used

• when the call was sent

Radio RCU calls

When this field is enabled, information on radio calls from RCUs will be printed on the log 
printer. The radio RCU calls log includes information on:

• which channel was used

• when the call was sent

Radio emergencies

When this field is enabled, information on radio emergencies will be printed on the log 
printer. The radio emergencies log includes information on:

• the alias or ID of the person who sent the emergency call

• when it was received

Radio patches

When this field is enabled, information on radio patches will be printed on the log printer. 
The radio patches log includes information on:

• who was included in the patch

• when the patch took place

• who patched the channels

Radio main/standby switches

When this field is enabled, information on radio main/standby switches will be printed on 
the log printer. The radio main/standby switches log includes:

• the name of the radio channel

• whether it switched from main to standby or from standby to main.

• the time the switch took place

Phone call progress

When this field is enabled, information on phone call progress will be printed on the log 
printer. Phone call progress log includes:

• when calls were put on hold

• when calls were conferenced
CommandSTAR Lite System Database Manager Manual 5-7
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• to whom calls were conferenced

Logging port host

This field allows you to specify whether or not the system has a log printer, and whether 
the printer is linked to the CSDM Lite or to a console.

Logging port

This field allows you to specify the port on the console to which the logging printer will be 
linked. The entry in this field is fixed to “COM1”.

Logging port baud rate

This field allows you to specify the baud rate for the logging port. Choices are: 300, 1200, 
2400, and 9600.

Logging port data bits

This field allows you to specify the data bits for the logging port. Choices are: 7 and 8.

Logging port stop bits

This field allows you to specify the stop bits for the logging port. Choices are: 1 and 2.

Logging port parity

This field allows you to specify the parity for the logging port. Choices are: none, odd, and 
even.

Logging port handshake

This field allows you to specify the handshake for the logging port. Choices are: none and 
XON/XOFF.
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Info

The “Info” menu item displays the “General Information” screen.

Fields

Login level

The “Login level” field indicates the current user login level, Superuser, Supervisor, or 
User.

Software release

The “Software release” field indicates the software release version number of the CSDM 
Lite.

Free RAM

The “Free RAM” field indicates the amount of free random access memory (RAM) avail-
able on the CSDM Lite computer. 

Free disk space

The “Free disk space” field indicates the amount of free disk space available on the CSDM 
Lite computer.

Total disk space

The “Total disk space” field indicates the maximum capacity of the computer’s hard disk.

Clear Screen

The “Clear Screen” menu item allows you to clear system logs from the screen. 

Figure 5-8: General Information Screen
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Chapter 6
Setup Menu

The Setup menu has the following menu items:

• Software Setup

• Date and Time

• Account Management

• COM/Modem Setup

Software Setup

The “Software Setup” menu item displays the “Software Setup” screen.

Fields

Field auto detect

The “Field auto detect” field, when enabled, allows you to:

• automatically open menus by placing the cursor on the menu title

• automatically highlight fields by placing the cursor on the field

Figure 6-1: Software Setup Screen
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Screen saver enabled

The “Screen saver enabled” field enables the screen saver. The screen saver reduces the 
possibility that a screen display will burn an image into the face of the picture tube. The 
screen saver starts when the CSDM Lite position is idle for a predefined period of time 
(see the “Screen saver delay” field below). When the screen saver is on, the message 
Press any key to restore the CSDM moves at random around the screen at 5-second 
intervals. 

The screen saver only affects the screen display. While the screen saver is on, the CSDM 
Lite event logging capabilities are still enabled.

Screen saver delay

The “Screen saver delay” field allows you to specify the duration of time between the last 
touch of the keyboard and the start of the screen saver. Choices are: 1, 2, 3, 4, 5, 6, 7, 8, 
9, and 10 minutes.

Type of alarm

The “Type of alarm” field allows you to specify the type of alarm sound when a hardware 
failure occurs. The sound will be heard from the CDSM computer speaker. Choices are: 

• off 

• burst - 250ms on, 250ms off

• steady 

• single - one beep for every failure

Upd Date & Time Bios

The “Upd Date & Time Bios” field enables updating of the Personal Computer’s date and 
time coming from the system.

Date and Time

The date and time can be changed from the CSDM Lite and from each console. The “Date 
and Time” menu item displays the “Date and Time Setup” screen.

Figure 6-2: Date and Time Setup Screen
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Date and Time
Fields

Date

The “Date” field allows you to specify the year, month, and date for the system.

Time Format

The “Time Format” field allows you to specify whether the time is displayed in the 12 hour 
or 24 hour time format.

Time

The “Time” field allows you to specify the time of day in hours, minutes, and seconds.

Time Zone

The “Time Zone” field allows you to specify the time zone for any geographical location in 
North America. When the time zone is set, the system time will change twice a year 
according to the following table. (The time changes only if the CSDM Lite is the clock mas-
ter.)

Time Zone Abbreviations: 

Labrador and Yukon Other

Last Sunday of Oct.: 2 to 1 am Last Sunday of Oct.: 2 to 1 am

Last Sunday of April: 2 to 3 am First Sunday of April: 2 to 3 am

ST - standard time M - Mountain

DT - daylight savings time A - Atlantic

P - Pacific N - Newfoundland

E - Eastern L - Labrador

C - Central Y - Yukon
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Account Management

The “Account Management” menu item displays the “Account Management” screen.

When you select the desired user name, the EDIT and DELETE buttons become active.

Buttons

ADD

Select the “ADD” button to display the “Add Account” screen and add a User name/Pass-
word combination.

EDIT

Select the “EDIT” button to display the “Edit Superuser Account” screen or the “Edit 
Supervisor Account” screen and edit the user name/password combination.

To edit (change) your User name/Password combination:

1. Type the new user name in the “User’s Name” field and press [Enter]. 

2. Type the new password in the “Type New Password” field and press [Enter].

Figure 6-3: Account Management Screen

Figure 6-4: Edit Superuser Account Screen
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3. Type the new password in the “Re-Type New Password” field and select “OK”.

DELETE

Select the “DELETE” button to delete a User name/Password combination.

COM/Modem Setup

The “COM/Modem Setup” menu item allows you to set the parameters for a modem link or 
direct serial link to the CommandSTAR Lite system. 

The “COM/Modem Setup” menu item displays the “COM/Modem Setup” screen.

Fields

Port address

The “Port address” field allows you to specify the address for the COM port used by the 
modem or direct serial connection. COM port 1 is address 3F8 interrupt 4, COM port 2 is 
address 2F8 interrupt 3.

Interrupt port

The “Interrupt port” field allows you to specify the interrupt used by the modem or direct 
serial connection.

Dial-in sequence

The “Dial-in sequence” field allows you to specify the control characters that will instruct 
the modem to dial a specified number. After the letters “ATDT”, enter the phone number to 
be dialed.

Hang-up sequence

The “Hang-up sequence” field allows you to specify the control characters that will instruct 
the modem to hang-up and terminate communication.

Figure 6-5: COM/Modem Setup Screen
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Buttons

DIAL-IN

The “DIAL-IN” button allows you to initiate communication by instructing the CSDM Lite to 
send the dial-in sequence to the modem.

HANG-UP

The “HANG-UP” button allows you to halt communication by instructing the CSDM Lite to 
send the hang-up sequence to the modem.
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Chapter 7
Upgrade Menu

The Upgrade menu has the “Software Upload” menu item.

Note 1: Software uploading is a maintenance activity and should be performed by trained 
personnel. For more information on software uploading, please see the CommandSTAR 
Lite Installation and Troubleshooting manual.

Note 2: Before using the “Software Upload” menu item, ensure that the three files TSM.hi, 
TSM.lo, and Cop.x are copied to the CSDM Lite computer’s hard disk. If necessary, 
extract the files from an archive (e.g., a zip file). If any of the files are missing for the 
upload, the “File I/O Error” screen appears after the start upload process.

Software Upload

The “Software Upload” menu item allows you to upload software from the CSDM Lite 
directory in the CSDM Lite computer to the peripherals in the CommandSTAR Lite system. 

The “Software Upload” menu item displays the “Software Upload Status” screen.

The “Software Upload Status” screen lists the processors to be upgraded, and has the fol-
lowing columns to identify processors:

• Node - identifies the console

• Pp - identifies the peripheral processor

Figure 7-1: Software Upload Status Screen
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• Processor - identifies the processor to be upgraded

• Status - identifies the status of the upload. The status column can display one of the 
following:

• Aborted

• Done

• In progress

• Time out

• Failed

• Bad file opening

• File I/O error

• File corrupted

• CRC - identifies the cyclic redundancy check (CRC) number of the software being 
uploaded

Field

Progress

The “Progress” field identifies the percent completion of the upload.

Buttons

START

The “START” button starts the upload.

The “ABORT” button stops the upload.
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Appendix A
The “Labels” Program

About the Labels Program

The Labels program is a Windows application that allows you to produce and print the 
labels for the operator module buttons on CommandSTAR Lite consoles. You can produce 
a label file with the CSDM Lite and use the Label program to print it, or you can use the 
Labels program to create a new label file.

To create a label file using the CSDM Lite, follow the instructions in Chapter 3 under File/
Report/Label.

The label file used by the label printing program has the file extension “.LBL”.

Installing the Labels Program

To install the Labels program

1. Place the “Labels Setup” diskette in a floppy disk drive.

2. Select the Windows “Start” button, then from the menu select “Run”.

The “Run” dialogue box appears.

3. In the “Open” field of the “Run” dialogue box, Type “a:\setup” or “b:\setup”, 
depending on the drive in which the setup diskette was placed. Click the “OK” button.

Figure A-1: Run Dialogue Box
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Starting the Labels Program
The "CommandSTAR Setup" window appears.

4. Select "Continue".

You are prompted to accept or change the default directory "C:\CSDM\LABELS".

5. Select "Continue".

The installation starts.

6. When the installation is complete, select "OK".

A “CommandSTAR” program group containing the “Labels” icon is created. Close the pro-
gram group window. Installation of the Labels program is now complete.

Starting the Labels Program

To start the Labels program, select the Windows Start button, then from the menu select 
Programs/CommandSTAR/Labels

The “Labels” program window appears.

Help Feature

For information on how to use the Labels program, use the “Help” feature.

To start the “Help” feature, select “Contents” from the “Help” menu.

Figure A-2: Labels Program Window
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Toolbar
Toolbar

The Labels program has the following toolbar buttons:

This button allows you to create a new label file.

This button allows you to open an existing label file.

This button allows you to save the current file.

This button allows you to save the current file under 
a new name.

This button allows you to print the labels.

This button allows you to select a module from a list.

These buttons allow to select the previous and next 
module in the list.

This button allows you to edit the labels of the 
selected module.

This button allows you to add a new module to the 
list.

This button allows you to delete the selected mod-
ule.
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Creating a New Label File
Creating a New Label File

You can produce a label file with the CSDM Lite or you can use the Labels program to cre-
ate a new label file.

To create a label file using the CSDM Lite, follow the instructions in Chapter 3 under File/
Report/Label.

To create a new label file using the labels program:

1. Select , or “File/New label file”.

The “System Information” dialogue box appears.

2. Add the system name and system number. 

3. Select OK.

, , and  become active.

4. Select , or “Modules/Add”, to add a module.

Figure A-3: System Information Dialogue Box
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Adding and/or Editing Label Text
The “Add Module” dialogue box appears.

5. Select one of the listed modules and click “OK”

The module label dialogue box appears for the selected module.

6. Type in the text for the labels in the fields provided. Click “OK”.

7. Select “File/Save” to save the label file.

The “Save As” dialogue box appears. 

8. Type in the name of the file and click “OK”.

You may now add more labels, modify, print, or delete existing labels.

Adding and/or Editing Label Text

To add and/or edit the label text:

1. Select the desired module by using  or, “Module/View Next” or”Module/
View Previous”

2. Select , or “Module/Edit”.

Figure A-4: Add Module Dialogue Box
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Adding and/or Editing Label Text
The module label dialogue box appears for the selected module.

3. Select the field(s) you wish to edit.

The “Module Name” field allows you to add or modify the name of the module. The module 
name will be printed with the labels.

4. Click “OK”. 

A print preview of the label is displayed.

5. Save your changes.

Figure A-5: Module Label Dialogue Box
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Producing Labels
Producing Labels

To produce labels:

1. Select , or “File/Print”.

The “Print the Labels” dialogue box appears.

Use the “Select font” button to select the font for the labels.

Use the “Printer Setup” button to select the printer.

Select the “All Module” button to print the labels for all the modules.

Select the “Selected Module” button to print the module currently selected on the combo 
list box (directly below the “Selected Module” button).

2. Select “Print”.

The Labels print (see Figure A-7).

3. Use scissors to cut out the labels.

4. Insert the labels into the slots provided on the CommandSTAR Lite operator modules.

Figure A-6: Print the Labels Dialogue Box
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Producing Labels
Figure A-7: Example of a Label Printout
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Appendix B
Paging Codes

Introduction

Over the years, as more and more radio channels were used, the need for special coding 
techniques for paging grew. As the demand increased, radio frequencies could no longer 
be used exclusively by one party. As a result, systems were developed with the ability to 
page one party or a sub-group from within a larger group sharing a radio channel.

These systems use paging codes that can be received by only one receiver. The industry 
developed code plans to manage these paging codes.

This appendix explains and shows the tables for 6 commonly used paging code formats:

• Motorola 1+1

• Motorola 2+2

• GE Type 99 Code Plans

• 5/6 sequential

• Reach Code Plans

• DTMF Frequencies

Motorola 1+1

Motorola 1+1 sends two frequencies, one after the other. It uses three digit pager codes 
and has 21 different code plans. The code plans range from B through Y (excluding I, O, 
and X). 

Example

Assume you are using code plan “B”, and you want to know the frequencies for the three 
digit pager code 543.

1. The first digit of the three digit pager code indicates the row on the Motorola 1+1 Code 
Plans table. On the Motorola 1+1 Code Plans table, at the intersection of row “5xx” 
and column “B”, is “1+3”.
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Motorola 1+1
2. The numbers 1 and 3 (1+3) indicate the columns on the Motorola 1+1 Frequencies 
table where the frequencies are listed. The number 4 and 3 from the three digit pager 
code 543 indicates the rows on the Motorola 1+1 Frequencies table.

3. The first frequency is on the Motorola 1+1 Frequencies table at the intersection of row 
4 and column 1. The first frequency is 410.8 Hz.

4. The second frequency is on the Motorola 1+1 Frequencies table at the intersection of 
row 3 and column 3. The second frequency is 304.7 Hz.

Motorola 1+1 Code Plans Table

B C D E F G H J K L

0xx 2+4 N/A N/A N/A N/A N/A N/A N/A N/A N/A

1xx 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1 1+1

2xx 2+2 2+2 2+2 2+2 1+3 1+3 1+3 1+4 1+4 1+5

3xx 3+3 1+2 1+2 1+2 3+3 3+3 3+3 4+1 4+1 5+1

4xx 1+2 4+4 1+5 2+1 4+4 3+1 3+1 4+4 4+4 1+6

5xx 1+3 1+4 5+5 1+6 3+1 5+5 1+6 5+5 1+6 5+5

6xx 2+1 2+1 2+1 6+6 1+4 1+5 6+6 1+5 6+6 6+6

7xx 3+1 4+1 5+1 6+1 4+1 5+1 6+1 4+5 6+1 6+1

8xx 2+3 2+4 2+5 2+6 3+4 3+5 3+6 5+4 4+6 5+6

9xx 3+2 4+2 5+2 6+2 4+3 5+3 6+3 5+1 6+4 6+5

M N P Q R S T U V W Y

4+2 4+2 4+2 4+2 4+2 4+2 4+2 4+2 4+2 4+2 N/A

2+3 2+3 2+3 2+4 2+4 2+5 3+4 3+4 3+5 4+6 A+A

2+2 2+2 2+2 2+2 2+2 2+2 4+3 4+3 5+3 6+4 B+B

3+3 3+3 3+3 4+2 4+2 5+2 3+3 3+3 3+3 5+6 Z+Z

4+4 3+2 3+2 4+4 4+4 2+6 4+4 4+4 3+6 4+4 A+B

3+2 5+5 2+6 5+5 2+6 5+5 5+5 3+6 5+5 5+5 A+Z

2+4 2+5 6+6 2+5 6+6 6+6 3+5 6+6 6+6 6+6 B+A

4+2 5+2 6+2 4+5 6+2 6+2 4+5 6+3 6+3 4+5 Z+A

3+4 3+5 3+6 5+4 4+6 5+6 5+4 4+6 5+6 5+4 B+Z

4+3 5+3 6+3 5+2 6+4 6+5 5+3 6+4 6+5 6+5 Z+B
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Motorola 1+1 Frequencies Table

Motorola 2+2

Motorola 2+2 sends four frequencies, the first two are sent at the same time then the sec-
ond two are sent at the same time. It uses four digit pager codes and has 3 different code 
plans. The code plans are A, B, and Z.

Example

Assume you are using code plan “A”, and you want to know the frequencies for the four 
digit pager code 5432.

1. The first two digits of the four digit pager code indicate the first two frequencies. The 
second two digits of the four digit pager code indicate the second two frequencies. 

2. At the intersection of row “5” and column “A”, is 602.6 Hz, which is one of the first two 
frequencies.

3. At the intersection of row “4” and column “A”, is 543.3 Hz, which is one of the first two 
frequencies.

4. At the intersection of row “3” and column “A”, is 489.8 Hz, which is one of the second 
two frequencies.

5. At the intersection of row “2” and column “A”, is 441.6 Hz, which is one of the second 
two frequencies.

1 2 3 4 5 6 A B Z

0 330.5 569.1 1092.4 321.7 553.9 1122.5 358.9 371.5 346.7

1 349.0 600.9 288.5 339.6 584.8 1153.4 398.1 412.1 384.6

2 368.5 634.5 296.5 358.6 617.4 1185.2 441.6 457.1 426.6

3 389.0 669.9 304.7 378.6 651.9 1217.8 489.8 507.0 473.2

4 410.8 707.3 313.0 399.8 688.3 1251.4 543.3 562.3 524.8

5 433.7 746.8 953.7 422.1 726.8 1285.8 602.6 623.7 582.1

6 457.9 788.5 979.9 445.7 767.4 1321.2 668.3 691.8 645.7

7 483.5 832.5 1006.9 470.5 810.2 1357.6 741.3 767.4 716.1

8 510.5 879.0 1034.7 496.8 855.5 1395.0 822.2 851.1 794.3

9 539.0 928.1 1063.2 524.6 903.2 1433.4 912.0 944.1 881.0
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Paging Codes
GE Type 99 Code Plans
Motorola 2+2 Frequencies Table

GE Type 99 Code Plans

The GE Type 99 Code Plan sends two frequencies, one after the other. It uses three digit 
pager codes and has 4 different code types. The code plans are X, Y, Z400, and Z100.

Example

Assume you are using code plan “X”, and you want to know the frequencies for the three 
digit pager code 345.

1. The first digit of the three digit pager code indicates the row on the GE Type 99 Code 
Plans table. On the GE Type 99 Code Plans table, at the intersection of row “3xx” and 
column “X”, is “A/B”.

2. The letters A and B (A/B) indicate the columns on the GE Type Frequencies table 
where the frequencies are listed. The numbers 4 and 5 from the three digit pager code 
345 indicates the rows on the GE Type Frequencies table.

3. The first frequency is on the GE Type Frequencies table at the intersection of row 4 
and column A. The first frequency is 847.5 Hz.

4. The second frequency is on the GE Type Frequencies table at the intersection of row 
5 and column B. The second frequency is 922.5 Hz.

A B Z

0 358.9 371.5 346.7

1 398.1 412.1 384.6

2 441.6 457.1 426.6

3 489.8 507.0 473.2

4 543.3 562.3 524.8

5 602.6 623.7 582.1

6 668.3 691.8 645.7

7 741.3 767.4 716.1

8 822.2 851.1 794.3

9 912.0 944.1 881.0

A 1011.6 1047.1 977.2

B 1122.1 1161.4 1084.0
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Paging Codes
GE Type 99 Code Plans
GE Type 99 Code Plans Table

GE Type 99 Frequencies Table

X Y Z400 Z100

0xx A/A B/B A/A C/C

1xx B/A C/B C/A N/A

2xx B/B C/C C/C N/A

3xx A/B B/C A/C N/A

4xx C/C N/A N/A N/A

5xx C/A N/A N/A N/A

6xx C/B N/A N/A N/A

7xx A/C N/A N/A N/A

8xx B/C N/A N/A N/A

A B C

0 682.5 652.5 667.5

1 592.5 607.5 712.5-

2 757.5 787.5 772.5

3 802.5 832.5 817.5

4 847.5 877.5 862.5

5 892.5 922.5 907.5

6 937.5 967.5 952.5

7 547.5 517.5 532.5

8 727.5 562.5 577.5

9 637.5 697.5 622.5

D 742.5 742.5 742.5
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Paging Codes
5 and 6 Tone Sequential Format
5 and 6 Tone Sequential Format

A preamble tone is sent prior to the 5 frequencies which is programmable for Motorola for-
mats and identical to the first frequency for Nec formats. An X tone is sent after the 5 fre-
quencies for odd 5th digits in the 6 tone format.

Example

Assume you want to know the frequencies for the five digit pager code 32045.

1. The first frequency is on the 5/6 Tone Frequencies table on row 3. The first frequency 
is 1023.0 Hz.

2. The second frequency is on the 5/6 Tone Frequencies table on row 2. The second fre-
quency is 882.0 Hz.

3. The third frequency is on the 5/6 Tone Frequencies table on row 0. The third fre-
quency is 600.0 Hz.

4. The fourth frequency is on the 5/6 Tone Frequencies table on row 4. The fourth fre-
quency is 1164.0 Hz.

5. The fifth frequency is on the 5/6 Tone Frequencies table on row 5. The fifth frequency 
is 1305.0 Hz.

5/6 Tone Frequencies Table

0 600.0

1 741.0

2 882.0

3 1023.0

4 1164.0

5 1305.0

6 1446.0

7 1587.0

8 1728.0

9 1869.0

X 2010.0

R 459.0
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Paging Codes
Reach Code Plans
Reach Code Plans

The Reach Code Plan sends two frequencies, one after the other. It uses three digit pager 
codes and has 1 code plan.

The order in which frequencies are sent depends on the order of the letters x and y in the 
Reach Code Plan table. The “x” frequency is sent first, the “y” frequency is sent second.

Example

Assume you want to know the frequencies for the three digit pager code 657.

1. The first digit of the three digit pager code indicates the row on the Reach Code Plan 
table. In the Reach Code Plan table on row “6yx” is “4/1”.

2. The numbers 4 and 1 (4/1) indicate the columns on the Reach Frequencies table 
where the frequencies are listed. The numbers 5 and 7 from the three digit pager code 
657 indicate the rows on the Frequencies table.

3. The frequency corresponding to the number 5 from the three digit pager code 657 is 
on the Reach Frequencies table at the intersection of row 5 and column 4. The fre-
quency is 990.0 Hz.

4. The frequency corresponding to the number 7 from the three digit pager code 657 is 
on the Reach Frequencies table at the intersection of row 7 and column 1. The fre-
quency is 2196.0 Hz.

Reach Code Plan Table

0yx 5/3

1xy 1/2

2yx 2/1

3xy 3/4

4yx 4/3

5xy 1/4

6yx 4/1

7xy 1/5

8yx 5/1

9xy 3/5
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Paging Codes
DTMF Frequencies
REACH Frequencies Table

DTMF Frequencies

A DTMF (Dual Tone Multi Frequency) pager code may be any number of digits and allow-
able characters in length up to a maximum of 16. The set of digits and allowable charac-
ters are 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, *, and #. Each digit or character is associated 
with two tones that are sent simultaneously. 

Example

Assume you want to know the frequencies for the letter D.

1. The letter D on the DTMF Frequency table is at the intersection of the frequencies 
941.0 Hz and 1633.0 Hz.

2. When “D” is pressed, the frequencies 941.0 Hz and 1633.0 Hz are sent simulta-
neously.

DTMF Frequencies Table

1 2 3 4 5

0 1980.0 1177.0 1400.0 832.0 588.0

1 2704.0 1608.0 1912.0 1137.0 804.0

2 2612.0 1553.0 1847.0 1098.0 776.0

3 2523.0 1500.0 1784.0 1061.0 750.0

4 2437.0 1449.0 1723.0 1025.0 725.0

5 2354.0 1400.0 1664.0 990.0 700.0

6 2274.0 1352.0 1608.0 956.0 676.0

7 2196.0 1306.0 1553.0 923.0 653.0

8 2121.0 1261.0 1500.0 892.0 631.0

9 2049.0 1219.0 1449.0 862.0 609.0

1209.0 1336.0 1477.0 1633.0

697.0 1 2 3 A

770.0 4 5 6 B

852.0 7 8 9 C

941.0 * 0 # D
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Appendix C
Call Event Logging Printout Examples

Introduction

The following are examples of call event logging printouts. For further information on call 
event logging, refer to Chapter 5, “Diagnostics Menu”.

CallOn :
DD/MM/YYYY   XX:XX:XX   Incoming call on "ChannelName"

CallOff :
DD/MM/YYYY   XX:XX:XX   End of incoming call on "ChannelName"

PttOn :
DD/MM/YYYY   XX:XX:XX   "OprName" transmitting on "ChannelName"

BaseICOn :
DD/MM/YYYY   XX:XX:XX   "OprName" sending intercom on "ChannelName"

RCUOn :
DD/MM/YYYY   XX:XX:XX   RCU transmitting on "ChannelName"

EndOfPtt :
DD/MM/YYYY   XX:XX:XX   End of transmission on "ChannelName"

CallerIdIn :
DD/MM/YYYY   XX:XX:XX   "IdName" id received on "ChannelName"

EmerDeclare :
DD/MM/YYYY   XX:XX:XX   "IdName" emergency rcvd on "ChannelName"

EmerClearLog :
DD/MM/YYYY   XX:XX:XX   Emergency cleared on "ChannelName"

PatchOn :
DD/MM/YYYY   XX:XX:XX   "ChannelName" patched by "OprName"
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Call Event Logging Printout Examples
Introduction
PatchOff :
DD/MM/YYYY   XX:XX:XX   "ChannelName" unpatched by "OprName"

LLPatchOn :
DD/MM/YYYY   XX:XX:XX   "LineName" patched by "OprName"

LLPatchOff :
DD/MM/YYYY   XX:XX:XX   "LineName" unpatched by "OprName"

CDPatchOn :
DD/MM/YYYY   XX:XX:XX   Call director patched by "OprName"

CDPatchOff :
DD/MM/YYYY   XX:XX:XX   Call director unpatched by "OprName"

SwToMain :
DD/MM/YYYY   XX:XX:XX   "ChannelName" switched to main

SwToStby :
DD/MM/YYYY   XX:XX:XX   "ChannelName" switched to standby

LLsJoined :
DD/MM/YYYY   XX:XX:XX   "LineName" and "LineName2" connected

LLsUnjoined :
DD/MM/YYYY   XX:XX:XX   "LineName" and "LineName2" disconnected

OprToOprRing :
DD/MM/YYYY   XX:XX:XX   "OprName2" ringing "OprName"

OprToOprBusy :
DD/MM/YYYY   XX:XX:XX   "OprName" cannot receive call from "OprName2"

OprAnswersOpr :
DD/MM/YYYY   XX:XX:XX   "OprName2" answers call from "OprName"

OprToOprStopRing :
DD/MM/YYYY   XX:XX:XX   "OprName2" stops ringing "OprName"

OprReleasesOpr :
DD/MM/YYYY   XX:XX:XX   "OprName2" releases call with "OprName"

OprRetrieved :
DD/MM/YYYY   XX:XX:XX   "OprName2" retrieves call with "OprName"
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Call Event Logging Printout Examples
Introduction
OprHeld :
DD/MM/YYYY   XX:XX:XX   "OprName2" puts call with "OprName" on hold

OprsUnjoined :
DD/MM/YYYY   XX:XX:XX   "OprName2" and "OprName" disconnected

OprsJoined :
DD/MM/YYYY   XX:XX:XX   "OprName2" and "OprName" connected

LLRingIn :
DD/MM/YYYY   XX:XX:XX   "LineName" ringing in

LLStopRing :
DD/MM/YYYY   XX:XX:XX   "LineName" stops ringing

LLHeld :
DD/MM/YYYY   XX:XX:XX   "OprName" puts call with "LineName" on hold

LLRetrieved :
DD/MM/YYYY   XX:XX:XX   "OprName" retrieves call with "LineName"

LLAnswersOpr :
DD/MM/YYYY   XX:XX:XX   "LineName" answers call from "OprName"

OprReleasesLL :
DD/MM/YYYY   XX:XX:XX   "OprName" releases call with "LineName"

OprAnswersLL :
DD/MM/YYYY   XX:XX:XX   "OprName" answers call from "LineName"

LLOnHook :
DD/MM/YYYY   XX:XX:XX   "LineName" on hook'

OprAndLLJoined :
DD/MM/YYYY   XX:XX:XX   "OprName" and "LineName" connected

OprAndLLUnjoined :
DD/MM/YYYY   XX:XX:XX   "OprName" and "LineName" disconnected

OprSeizesLL :
DD/MM/YYYY   XX:XX:XX   "OprName" seizes "LineName"
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Call Event Logging Printout Examples
Introduction
OprRingsLL :
DD/MM/YYYY   XX:XX:XX   "OprName" rings out "LineName"

CDCallOn :
DD/MM/YYYY   XX:XX:XX   "OprName" call director off-hook

CDCallOff :
DD/MM/YYYY   XX:XX:XX   "OprName" call director on-hook

CallAlertDeclare :
DD/MM/YYYY   XX:XX:XX   "Id" call alert rcvd on "ChannelName"

UserStatusDeclare,
UserMsgDeclare,
VehicleStatusDeclare :
DD/MM/YYYY   XX:XX:XX   "Id" "StatusName" ch "ChannelName"

VoiceAlertDeclare :
DD/MM/YYYY   XX:XX:XX   "Id" voice alt rcvd on "ChannelName"
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Glossary

ACM Auxiliary Control Module

ADT Atlantic Daylight Time

AST Atlantic Standard Time

Aux, aux Auxiliary

CCM Channel Control Module

CDT Central Daylight Time

Cluster A group of consoles in a CommandSTAR system

CO Central Office

CSDM Lite CommandSTAR Lite System Database Manager

CST Central Standard Time

DA button Direct Access button, a button on a ACM allowing an operator direct 
access to an entity.

dB decibel; a unit used to express relative difference in power, usually 
between acoustic or electric signals, equal to ten times the common 
logarithm of the ratio of the two levels.

dBm decibel relative to 1 milliwatt

DOS Disk Operating System

DTMF Dual Tone Multiple Frequency - tones created by touch tone phones

EDT Eastern Daylight Time

EST Eastern Standard Time

Hz A unit of frequency equal to one cycle per second.

I/F Interface

IA Indirect Access

KHz kilo-hertz; thousand hertz (thousand cycles per second)

LDT Labrador Daylight Time
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Glossary
LST Labrador Standard Time

MDT Mountain Daylight Time

Module Hardware: freestanding (rack-mounted) hardware unit having controls 
for one or more circuit terminations. Examples: ACM, CCM, CO, DC, 
4-channel, Digital

MRC Mobile Radio Communications

ms millisecond

MST Mountain Standard Time

NDT Northwest Territories Daylight Time

NST Northwest Territories Standard Time

Operator Module An ACM or a CCM. 

PA Public Address

Patch An operation by which a set of radio channels, telephone lines, and 
enhanced call director circuits are actively communicating with one 
another without operator interaction and they are temporarily con-
nected for telecommunications

PC Personal Computer

PDT Pacific Daylight Time

PST Pacific Standard Time

PTT Push (or Press) To Talk

RAM Random Access Memory

RCU Remote Control Unit

ROM Read Only Memory

RX, Rx Receive / Received / Receiving audio or data

TX, Tx Transmit / Transmitted / Transmitting audio or data

YDT Yukon Daylight Time

YST Yukon Standard Time
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Index
A

Access level and password, adding 4-26
Access level, changing 4-27
Account Management

Add 6-4
Delete 6-5
Edit 6-4

Active configuration 2-3
Alarm button 4-18
Alert button 4-18
Alias

Add 4-52
Delete 4-52
Delete all 4-52
Edit 4-52

Alias of caller 4-53
Alias Page button 4-18
All Mute button 4-18
All mute level 4-6
All mute time-out delay, setting duration of 4-6
APB button 4-18
auto login 4-7
Aux1 I/O button 4-22
Auxiliary I/O

Add 4-70
Alarm 4-74
Delete 4-70
Edit 4-70
I/O ID 4-71
Opto debounce 4-74
Output mode 4-71
Relays 4-72
Safety switch 4-71
Type 4-71

B

BaseICom button 4-18
BIOS, update date and time 6-2
Button assignments 4-13
Button features 4-18

Alarm 4-18
Alert 1, 2, and 3 4-18
Alias page 4-18
All Mute 4-18
APB 4-18
Aux I/O (Auxiliary I/O 1 and 2) 4-22
BaseICom 4-18
Call Director 4-19
Call Director TX 4-19
Clear 4-19
DA (Direct Access) 4-19
Emergency Alarm 4-19
Emergency Clear 4-19
Enter RAC 4-19
F1/2 Aux 4-22
F1/2 Cpl 4-22
F1/2 Shr 4-22
F3/4 Cpl 4-22
F3/4 Shr 4-23
F5/6 Cpl 4-22
F5/6 Shr 4-23
Flash 4-20
Frequency 4-20
Hold 4-20
I/O 4-20
Line1 or Line 2 4-19
Man Page (manual page) 4-20
Monitor 4-20
MSel Mem 

(Multi-Select with memory) 4-20
Multi-Sel (Multi-Select) 4-20
None 4-20, 4-23
Page TX (Page Transmit) 4-20
Patch 4-21
Patch Mem 4-21
Patch TX 4-21
PhoneAssist 4-21
PhonICom (Phone Intercom) 4-21
PL A/B 4-23
PL C/D 4-23
PL E/F 4-23
Queue 4-21
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Index
Radio Assist 4-21
Receive 4-21
Release 4-21
Repeat 4-24
Ring Disable 4-21
RX F1/F2 4-24
RX F3/F4 4-24
RX F5/F6 4-24
Safety 4-22
Secure 4-24
Speed Pg (Speed Page) 4-22
Station 4-24
Takeover 4-24
TX F1/F2 4-24
TX F3/F4 4-24
TX F5/F6 4-25
Wldcard 1 and 2 4-25

C

Call detection method 4-30
Call Director button 4-19
Call Director TX button 4-19
Call director type, specifying the 4-7
Call event logging 5-6

Logging port 5-8
Logging port baud rate 5-8
Logging port data bits 5-8
Logging port handshake 5-8
Logging port host 5-8
Logging port parity 5-8
Logging port stop bits 5-8
Phone call progress 5-7
Radio emergencies 5-7
Radio incoming calls 5-6
Radio intercom calls 5-7
Radio main/standby switches 5-7
Radio outgoing calls 5-6
Radio patches 5-7
Radio RCU calls 5-7

Caller alias 4-51
Caller ID format 4-33
Caller ID min. time disp, setting the 4-5
CCSM button assignment moving 4-15
CCSM button assignments 4-14
Channel relay 4-32
Clear button 4-19
Clear Screen 5-9
Clock host, setting the 4-3
Clock port, setting the 4-3
Clock source, setting the 4-3

Clock type, setting the 4-3
COM/Modem setup 6-5
Configuration file 3-1

Loading 3-1
Modifying 3-1, 4-1
New 3-5
Report generation

Configuration 3-7
Label 3-6

Saving 3-3
Uploading 3-1, 3-4

Configuration menu 4-1
Auxiliary I/O 4-70
Console 4-5

Configuration 4-5
Console Layout 4-12
Control Assignment 4-13
Operator module 4-8
Password Configuration 4-26

General 4-2
Paging 4-56

Custom Page 4-56
External Pager 4-63
Manual Page 4-64
Page Format 4-58
Paging Aliases 4-67
Speed Page 4-65

Phone Line 4-54
Radio Channel 4-28

Assignment 4-41
Caller ID list 4-51
Configuration 4-28
Cross-Muting 4-41
DC Signaling 4-48
Tone Signaling 4-42

Console
All mute level, setting the 4-6
All mute time-out delay, 

setting duration of 4-6
Call director type, specifying the 4-7
Console auto login 4-7
Console chime, selecting the 4-6
Console type, specifying the 4-8
Dual button features, moving 4-17
Landline audio level, setting the 4-7
Name 4-5
Patched call director level, setting the 4-7
Setting date and time, 

enable or disable 4-6
STAT-ALERT PTT ID, specifying the 4-7
Switch audio to speaker 
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Index
during call director call 4-6
Console auto login 4-7
Console chime 4-6
Console Layout, creating a new 4-12
Console type, specifying the 4-8
Control Assignment 4-13
Control Assignment, validate 4-14
Cross-mute attenuation level, setting the 4-2
CSDM Lite

Basic 2-3
CommandSTAR Lite 

System Database Manager 1-1
Comprehensive 2-3
Connected or not connected 

to the system 2-2
Enhanced 2-3
Installing 2-1
Login 2-4
Login privileges 2-3
Logout/Exit 2-5
Navigating 2-1
Passwords 2-3
Running as a DOS Window 2-2
Starting 2-2
User levels 2-3
Usernames 2-3

Custom Page
Add 4-56
Code 4-57
Delete 4-56
Edit 4-57
First tone duraton 4-57
First tone frequency 4-57
Inhibit delay 4-58
Intertone delay 4-57
PC CSL voice annotation 4-58
Second tone duration 4-58
Second tone frequency 4-57

D

DA button 4-19
Date and Time

Date 6-3
Time 6-3
Time Format 6-3
Time Zone 6-3

Date and time setup 4-6
DC Signaling Plan

Copy 4-49
DC plan ID 4-50

Delete 4-49
Edit 4-49
Monitor supported 4-50
New 4-49
PL strip current 4-51
PL strip supported 4-51
Repeater supported 4-50
RX frequencies 4-50, 4-51
Transmit frequencies 4-49
TX frequencies 4-51

DC signaling plan 4-34
Diagnostic logs 5-1
Diagnostics menu 5-1

Call Event Logging 5-6
Clear Screen 5-9
Info 5-9
Status 5-3
View Logs 5-1

Direct Access button 4-19
DTMF decode settings 4-38
DTMF Selective call 4-34

E

Edit password and access level 4-27
EmerClr button 4-19
Emergency Alarm button 4-19
Enabling or disabling

Assigning a channel 
to an operator module 4-41

Busy timer for mute monitor 4-37
Mute monitor 4-37
Parallel unit 4-33
PL Strip supported 4-34
Priority marker 4-40
PTT relay 4-32
Radio Channel cross-mute 4-41

Enter RAC button 4-19
Exiting the CSDM Lite 2-5
Exiting the SMART 3-9
External Pager

Channel steering 4-63
Frequency steering 4-63
Input level 4-63
Ptt location 4-64

F

F1/2 Aux 4-22
F1/2 Cpl button 4-22
F1/2 Shr button 4-22
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Index
F3/4 Cpl button 4-22
F3/4 Shr button 4-23
F5/6 Cpl button 4-22
F5/6 Shr button 4-23
Fields and lists 2-8

Buttons 2-10
Check box fields 2-9
Edit fields 2-8
Matrices 2-11
Scroll lists 2-10
Selection list fields 2-9

File menu
Exit/Logout 3-9
New 3-5
Report 3-6

Configuration 3-7
Label 3-6

Save 3-3
Upload 3-4

First auxiliary I/O 4-31
Flash button 4-20
Free disk space 5-9
Free RAM 5-9
frequencies

Wildcard 4-35
Frequency button 4-20
Full duplex patch, enabling 4-4

G

General information 5-9

H

Help screen 2-6, 2-7
High speed mute 4-31
Hold button 4-20

I

I/O button 4-20
Installing the CSDM Lite 2-1
Introduction 1-1

CSDM Lite, About the 1-1
Manual, About this 1-2

K

Key functionality 2-7
Backspace key 2-7
Delete key 2-7

Enter key 2-7
Escape key 2-7
F1 key 2-8
Home/End keys 2-8
Insert keys 2-7
Left/Right arrow keys 2-8
Page up/Page Down keys 2-8
Shift plus tab keys 2-7
Tab key 2-7
Up/Down arrow keys 2-8

L

Labels A-1
About A-1
Adding and/or editing A-5
Creating a new label file A-4
Help A-2
Installing A-1
Producing labels A-7
Toolbar A-3

Landline audio level, setting the 4-7
Line 1 or Line 2 button 4-19
Location 4-32
Logging in to the CSDM Lite 2-4
Logging out of the CSDM Lite 2-5
Login level 5-9

M

Main/Standby relay 4-31
Manual Page

Page format 4-65
Voice annotation 4-65

Manual Page button 4-20
Menu bar 2-5
Menu map 2-6
Mobile Radio Type 4-34
Mode 4-30
Modem setup 6-5

Dial-in 6-6
Dial-in-sequence 6-5
Hang-up 6-6
Hang-up sequence 6-5
Interrupt port 6-5
Port address 6-5

Monitor button 4-20
Mouse functions 2-6
Msel Mem button 4-20
Multi-Select button 4-20
Mute
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Index
All mute level 4-6
All mute time-out delay 4-6
Mute monitor 4-37
Muting level for channel 4-34
Radio channel cross-mute 4-41

N

Name
Console 4-5
Radio Channel 4-30

Navigating 2-1
Fields and lists 2-8
Help screen 2-6, 2-7
Key functionality 2-7
Menu bar 2-5
Menu map 2-6
Mouse functions 2-6

None button 4-20, 4-23
Num. wires 4-31
Number of PL/DPL 4-35

O

Operator Modules 4-8
Operator modules

Moving button assignments 4-13
Operator modules, adding 4-9
Operator modules, deleting 4-9
Operator modules, viewing settings 4-9

P

Page Format
Add 4-58
Code plan 4-60
Delete 4-58
Edit 4-59
First tone duration 4-60
Gap delay 4-61
Group call duration 4-60
Header duration 4-62
Inhibit delay 4-60
Interdigit duration 4-62
Intertone delay 4-60
Name 4-59
Page format

basic 4-59
extended 4-59

PC CSL voice annotation 4-62
Preamble 4-61

Preamble duration 4-61
Pulse off duration 4-62
Pulse on duration 4-62
Second tone duration 4-60
STAT-ALERT type 4-60
Tone duration 4-60
Tone frequency 4-62
Trailer duration 4-62
X tone/gap duration 4-61

Page Transmit button 4-20
Paging

Channel steering for alias 4-68
Channel steering for external pager 4-63
Custom Page 4-56
External Pager 4-63
Frequency steering 

for external pager 4-63, 4-69
Manual Page 4-64
Page code for alias 4-68
Page Format 4-58
Page format for alias 4-68
Page format for manual page 4-65
Paging alias name 4-68
Paging Aliases 4-67
Speed Page 4-65
Voice annotation duration for alias 4-68
Voice annotation for manual page 4-65

Paging Aliases
Add 4-67
Alias name 4-68
Channel steering 4-68
Delete 4-68
Edit 4-68
Frequency steering 4-69
Load from disk 4-69
Page code 4-68
Page format 4-68
Save to Disk 4-69
Voice annotation 4-68

Paging codes B-1
5/6 Tone Sequential Format B-6
DTMF Frequencies B-8
GE Type 99 Code Plans B-4
Introduction B-1
Motorola 1+1 B-1
Motorola 2+2 B-3
Reach Code Plans B-7

Paging package, setting the 4-3
Parallel Status 4-31
Parallel unit 4-33
Password Configuration 4-26
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Password, adding 4-26
Password, assigning access level to 4-26
Password, changing 4-27
Password, deleting 4-27
Patch button 4-21
Patch Mem button 4-21
Patch TX button 4-21
Patched call director level, setting the 4-7
PC CSL voice annotation 4-58, 4-62
Phone Assist button 4-21
Phone hangover delay, setting the 4-5
Phone Line

Dialing mode 4-55
Edit 4-54
Hook flash duration 4-55
Name 4-54

PhonICom button 4-21
PL A/B button 4-23
PL C/D button 4-23
PL E/F button 4-23
PL strip supported 4-34
Priority marker 4-40
PTT relay 4-32

Q

Queue button 4-21

R

Radio Assist button 4-21
Radio Channel

Alias ID 4-53
Alias radio channel 4-53
Alias, specify 4-53
Call detection method 4-30
Caller ID format 4-33
Channel Relay 4-32
Cross-mute attenuation level, 

setting the 4-2
Cross-Muting 4-41
DC Signaling 4-48, 4-51
DC signaling plan 4-34
DTMF decode settings 4-38
DTMF Selective call 4-34
First auxiliary I/O 4-31
High speed mute 4-31
Location 4-32
Main/Standby relay 4-31
Mobile Radio Type 4-34
Mode 4-30

Muting level 4-34
Name 4-30
Num. wires 4-31
Number of PL/DPL 4-35
Parallel Status 4-31
Parallel unit 4-33
PL strip supported 4-34
Priority marker 4-40
PTT relay 4-32
Recorder level 4-34
Relay for remote repeat 4-33
Remote repeat disable 4-32
Repeat disable relay 4-33
Repeat function for the channel 4-32
RX detect threshold 4-39
RX hangover delay 4-40
RX impedence 4-40
RX level 4-39
RX multi-frequency 4-33
Second auxiliary I/O 4-31
Signaling method 4-33
STAT-ALERT settings 4-35
Talk Permit 4-34
Talk Permit Settings 4-38
Tone Signaling 4-42
Tone signaling plan 4-34
TX level 4-39
TX multi-frequency 4-33
TX Timeout 4-40
TX Voice Delay 4-31
Unselect speaker 4-34
Voice encryption 4-31
Wildcard frequencies 4-35

Radio Channel assignment 4-41
Radio channel, adding main 4-29
Radio channel, changing settings 4-29
Receive button 4-21
Recorder level 4-34
Relay for remote repeat 4-33
Release button 4-21
Remote repeat disable 4-32
Repeat button 4-24
Repeat disable relay 4-33
Repeater 4-32
Ring Disable button 4-21
RX detect threshold 4-39
RX F1/F2 button 4-24
RX F3/F4 button 4-24
RX F5/F6 button 4-24
RX hangover delay 4-40
RX impedence 4-40
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RX level 4-39
RX multi-frequency 4-33

S

Safety button 4-22
Saving a configuration file 3-3, 4-1
Screen saver 2-8
Search for text in a report 3-7
Second auxiliary I/O 4-31
Secure button 4-24
Setup menu 6-1

Account Management 6-4
COM/Modem Setup 6-5
Date and Time 6-2
Software setup 6-1

signaling method 4-33
Signaling protocol type 4-53
Simul-select button 4-20
SMART

General information 5-9
Software release 5-9
Software setup

Field auto detect 6-1
Screen saver delay 6-2
Screen saver enabled 6-2
Type of alarm 6-2
Upd Date & Time Bios 6-2

Software Upload 7-1
Software upload

Progress 7-2
Start 7-2

Speed page button 4-22
Starting the CSDM Lite 2-2
STAT-ALERT PTT ID, specifying the 4-7
STAT-ALERT settings 4-35
Station button 4-24
Status 5-3
Switch radio to speaker 4-6
System status 5-1

T

Takeover button 4-24
Talk Permit

Radio Channel 4-34
Settings 4-38
Tone Signaling Plan 4-44
Transmit frequencies screen 4-44

Tone Signaling Plan
Clear 4-47

Coded 4-47
Copy 4-43
Delete 4-43
Disable frequency 4-47
Edit 4-43
Enable frequency 4-47
Encryption supported 4-47
Function tone gain 4-46
Hold tone gain 4-46
Inter function delay 4-47
Monitoring 4-47
New 4-43
PL strip frequency 4-47
PL strip supported 4-47
PL/DPL frequency 4-48
Private Line/Digital Private line 

frequencies 4-46
Receive frequencies 4-45
Repeater disable frequency 4-47
Repeater enable frequency 4-47
Repeater supported 4-47
RX frequency 4-48
Secure and hold tone 4-46
Secure tone duration 4-46
Secure tone gain 4-46
Talk Permit 4-44
Tone plan ID 4-46
Transmit frequencies 4-44
TX frequency 4-48
Wildcard frequencies 4-45
Wildcard frequency 4-48

Tone signaling plan 4-34
Total disk space 5-9
TX F1/F2 button 4-24
TX F3/F4 button 4-24
TX F5/F6 button 4-25
TX level 4-39
TX multi-frequency 4-33
TX Timeout 4-40
TX Voice Delay 4-31

U

Unselect callers ID, enabling 4-4
Unselected speaker 4-34
Update date and time 6-2
Upgrade menu 7-1

Software Upload 7-1
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V

View Logs
Browse 5-2, 5-3

Voice annotation
Custom Page 4-58
for alert 1, 2, and 3, setting the 4-2
General Configuration Screen 4-2
Manual Page 4-65
Page Format 4-62
Paging Aliases 4-68
PC CSL 4-58, 4-62

Voice Delay, TX 4-31
Voice encryption 4-31

W

Wildcard frequencies 4-35
wires, Num. 4-31
WldCard 1 and 2 button 4-25
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